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Read this Instruction Manual thoroughly before using the product.

Thank you for purchasing Shimadzu analytical instrument workstation “GCMSsolution” (hereafter referred to as “the 
software” or “GCMSsolution”).

This manual describes the procedures for operating this product. Read this manual thoroughly before using the 
product and operate the product in accordance with the instructions in this manual.

Keep this manual for future reference.

This manual assumes that the reader is knowledgeable of basic operations of Windows. For the operation of 
Windows, refer to the instruction manual that comes with that product.

For information about how to use the GCMS-TQ NX series gas chromatograph mass spectrometer, its operating 
precautions, and so on, refer to the Instruction Manual for each instrument. 

• If the user or installation location changes, ensure that this Instruction Manual is transferred with the product.

• If this manual is lost or damaged, immediately contact your Shimadzu representative to request a replacement.

• To ensure safe operation, contact your Shimadzu representative for product installation, adjustment, or 
reinstallation (after the product is moved).

© 2018 Shimadzu Corporation All rights reserved.
Original version is approved in English.

Introduction

Important
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• Information in this manual is subject to change without notice and does not represent a commitment on the part of 
the vendor.

• Any errors or omissions which may have occurred in this manual despite the utmost care taken in its production will 
be corrected as soon as possible, although not necessarily immediately after detection.

• All rights are reserved, including those to reproduce this manual or parts thereof in any form without permission in 
writing from Shimadzu Corporation.

• Microsoft, Windows, and Excel are registered trademarks of Microsoft Corporation in the United States and/or other 
countries.
Adobe, Adobe logo and Adobe Acrobat, Adobe Acrobat Reader, Acrobat Distiller are trademarks or registered 
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Other company names and product names mentioned in this manual are trademarks or registered trademarks of 
their respective companies.

The TM and ® symbols are omitted in this manual.

• Microsoft® Windows® 7 Operating System is referred to as “Windows 7”.

Microsoft® Windows® 10 Operating System is referred to as “Windows 10”.

• Microsoft® Offfice Excel® 2016 is referred to as “Excel”.
• GCMS-TQ and GCMSsolution are registered trademarks of Shimadzu Corporation in the United States and Europe 

(Office for Harmonization in the Internal Market).
• Replacement parts for this product will be available for a period of seven (7) years after the product is discontinued.

Thereafter, such parts may cease to be available. Note, however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant manufacturers.

Notice
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This instruction manual uses the notation described below.

Indications Used in This Manual

Notation Meaning

! CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor to moderate 
injury or equipment damage.

Indicates additional information that is provided to ensure the proper use of this product.

^ Reference Indicates the location of related information.

Indicates information provided to improve product performance.

[  ] Indicates items displayed on the screen, such as buttons, menu selections, settings, windows, and 
icons. Example: Click [OK].
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Shimadzu Corporation provides the following warranty for this product.

Details

* If there is a document such as a warranty provided with the product, or there is a separate contact agreed upon that includes warranty 
conditions, the provisions of those documents shall apply.
The warranty period for products with special specifications or for system products is specified separately.

Product Warranty

1. Period: Please contact your Shimadzu representative for information about the period of this 
warranty.

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during the warranty 
period, Shimadzu will repair or replace the product/part free of charge. However, in the 
case of products which are usually available on the market only for a short time, such as 
personal computers and their peripherals/parts, Shimadzu may not be able to provide 
identical replacement products.

3. Limitation of Liability 1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for special, 
indirect, consequential, incidental or punitive damages, however caused regardless of the 
theory of liability, arising out of or related to the use of or inability to use the product, even if 
Shimadzu has been advised of the possibility of such damage.

2) In no event will Shimadzu's liability to you, whether in contract, tort (including negligence), 
or otherwise, exceed the amount you paid for the product.

4. Exceptions: Failures caused by the following are excluded from the warranty, even if they occur during 
the warranty period.
1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu 
designated companies

3) Product use in combination with hardware or software other than that designated by 
Shimadzu

4) Computer viruses leading to device failures and damage to data and software, including the 
product’s basic software

5) Power failures, including power outages and sudden voltage drops, leading to device 
failures and damage to data and software, including the product’s basic software

6) Turning OFF the product without following the proper shutdown procedure leading to device 
failures and damage to data and software, including the product’s basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high temperature or humidity 
levels, corrosive gasses, or strong vibrations

9) Fires, earthquakes or any other act of nature, contamination by radioactive or hazardous 
substances, or any other force majeure event, including wars, riots, and crimes

10)Product movement or transportation after installation

11) Consumable items
Note:Recording media, such as floppy disks and CD-ROMs are considered consumable 
items.
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PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE.
SHIMADZU Corporation ("SMZ") is willing to license the SMZ software provided herein, together with accompanying 
documentation (collectively "SOFTWARE") to you only upon the condition that you accept all of the terms and 
condition contained in this License Agreement. By using the SOFTWARE, you agree to be bound by the terms of this
Agreement. If you do not agree to all these terms of this Agreement, promptly return the unused SOFTWARE to the 
party (either SMZ or its reseller) from whom you acquired it to receive a refund of the amount you paid.

Software License Agreement

1. License: SMZ grants you a non-exclusive and nontransferable license to use the SOFTWARE 
subject to the following terms and conditions.

2. Limitation of Use: Except as specifically authorized by SMZ, you may NOT:
1) Use the SOFTWARE, or permit the SOFTWARE to be used, on more than one computer at 

any one time.
2) Copy the SOFTWARE except one (1) archival copy of the SOFTWARE.
3) Modify, reverse engineer, decompile, disassemble, or create derivative works based upon 

the SOFTWARE.
4) Transfer, rent, lease or grant any rights in the SOFTWARE in any form to anyone else.

3. Title and Ownership: This license is not for sale and it may not be assigned or sublicensed to anyone else. Title 
and all associated intellectual property rights to the SOFTWARE shall remain in SMZ and/
or its licensor.

4. Upgrades: You are entitled to receive all official software upgrades for the SOFTWARE that SMZ will 
release as deemed necessary by SMZ. An upgrade means certain supplemental program 
modules and/or information for bug fixing and/or updates to the defects and/or failures of 
the SOFTWARE that are acknowledged or confirmed by SMZ. An upgrade excludes 
hardware, network, consulting services, third party products, operation and general 
computer system maintenance. All supplemental program module for upgrades and 
enhancements furnished to you shall be deemed to be part of the SOFTWARE and 
subject to the terms and conditions set forth in this Agreement.

5. Limited Warranty: SMZ warrants that for a period of one (1) year from the date of purchase, as evidenced by 
a copy of the receipt, the media on which SOFTWARE is furnished will be free of defects 
in materials and workmanship under normal use.
Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy and the 
entire liability of SMZ and its suppliers under this limited warranty will be, at SMZ's option, 
repair, replacement, or refund of the Software if reported (or, upon request, returned) to 
the party supplying the SOFTWARE to you. In no event does SMZ warrant that the 
Software is error free or that you will be able to operate the SOFTWARE without problems 
or interruptions.
EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING FROM A xvi Introduction 
COURSE OF DEALING, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED 
TO THE EXTENT ALLOWED BY APPLICABLE LAW.

6. Limitation of Liability: IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, 
OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE 
DAMAGES, HOWEVER CAUSED REGARDLESS OF THE THEORY OF LIABILITY, 
ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE SOFTWARE, 
EVEN IF SMZ HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. IN NO 
EVENT WILL SMZ'S LIABILITY TO YOU, WHETHER IN CONTRACT, TORT 
(INCLUDING NEGLIGENCE), OR OTHERWISE, EXCEED THE AMOUNT YOU PAID 
FOR SOFTWARE.
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7. Termination: This License is effective until terminated. You may terminate this License at any time by 
destroying all copies of SOFTWARE including any documentation. This License will 
terminate immediately without notice from SMZ if you fail to comply with any provision of 
this License. Upon termination, you must destroy all copies of SOFTWARE.

8. General: 1) This Agreement is the entire agreement. If any provision of this agreement is held invalid, 
the remainder of this agreement shall continue in full force and effect.

2) This Agreement shall be construed and governed in accordance with the laws of Japan, 
excluding its conflict of law rules.

3) The exclusive jurisdiction for any disputes arising out of or in connection with this 
Agreement shall be Kyoto District Court of Japan.

4) The invalidity or unenforceability of any provision of this Agreement shall not affect the 
validity or enforceability of any other provision.
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1Description

The GCMSsolution software for gas chromatograph mass spectrometers runs on Windows. 

This software controls the GCMS-TQ NX series and peripherals such as the autosampler and acquires 
data. It also analyzes acquired data and prints out analysis results. 

1.1 Features

This software has many functions for acquiring and analyzing data by using the GCMS-TQ NX series gas 
chromatograph mass spectrometer. The following introduces the main features of this software.

1. Automatic Adjustment of Retention Time Function (AART)

Even if the retention time of a compound has fluctuated, the software automatically corrects for this simply 
by performing data acquisition on the reference sample (n-alkane). 

2. Automatic Scan/SIM Parameter Creation Function (COAST)

With the COAST function, method files for MRM, simultaneous scan/MRM measurements and product ion 
scan can be created automatically from the Compound Table.

3. Compound Identification Support Function

This function helps identify compounds quickly and accurately by displaying chromatograms from multiple 
sets of data, such as data from samples with standard substances added, on the same window for easy 
comparison.

4. Quantitation Browser with Multianalyte Quantitation Function

This browser allows easily loading large quantities of analytical results and performing quantitative 
calculations for all the data simultaneously or adjusting or confirming chromatograms for identified 
components. It also allows printing area values, concentration values, and other quantitation results, which 
can improve the efficiency of quality control processes.

5. Similarity Search Function Based on Retention Indices

In addition to searches based on mass spectra similarity, searches can be further refined based on 
retention indices. This ensures components can be identified even among compounds with similar mass 
spectra.

6. Highly Flexible Report Customization

Chromatograms, spectra, quantitation results, or a variety of other report items can be freely laid out in any 
location or size. This allows creating a report format that is tailored to what you want.

7. GLP/GMP Support

The software is fully equipped with security, audit trail, hardware/software verification and QA/QC functions 
for GLP/GMP compliance.

8 Ecology Mode

Implementation of the ecology mode means that power and carrier gas consumption can be reduced when 
the instrument is standing by for data acquisition. 

ZStanius
Highlight
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1.2 Common Operations

This software comprises the following programs:

1.2.1 Starting Up the Program

1 Double-click a GCMSsolution program icon  (e.g. (GCMS Real Time Analysis)) on 

the desktop.

The [Login] window opens.

2 Select the user ID from the [User ID] list, and enter the password.

When logging in for the first time, select [Admin] in the [User ID] list and leave [Password] blank.

3 Click [OK].

[GCMS Real Time Analysis] program starts up.

Program Name Contents

[GCMS Realtime Analysis] 
program

Performs instrument start/stop, system configuration and data acquisition. 

[GCMS Analysis Editor] 
program

Creates and edits method files or batch files during data acquisition. 

[GCMS Postrun Analysis] 
program

Performs data processing such as qualitative processing, quantitative 
processing, and printing of reports. 

[GCMS Browser] program Performs data processing on multiple data, such as qualitative processing, 
quantitative processing, and printing of reports. 



 GCMSsolution Instruction Manual   3

1.2  Common Operations

1

1.2.2 Explanation of Window Parts

No. Name Explanation

1 Title Bar Displays information such as name of the currently running 
program, window name, currently loaded file name, and logged 
in user name. 

2 (Close) button Clicking this button exits the program.

3 Menu Bar Displays the menus that are enabled for the currently used 
window and the rights of the currently logged in user. 

4 Tool Bar Displays the icons of frequently used menu items and the icons 
for operating analytical instruments. 

5 Window Different windows such as [Acquisition] and [Batch Table] are 
displayed in this frame of the program. The currently displayed 
window is switched by clicking icons on the assistant bar or 
tabs displayed under each window. 

6 Output window Displays an operation history of data acquisition and error 
messages that occur.

7 Data Explorer Displays files in the currently selected folder according to the 
type of file selected by the tabs underneath. The content of files 
is displayed by dragging-and-dropping the file in the [Data 
Explorer] sub-window onto the window. 

8 Assistant Bar Icons corresponding to commands are arranged according to 
the general order of operations. Normally, click an icon on this 
bar to select a respective operation. 

1

3
4

2

5

6

78
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1.2.3 How to Use Data Explorer
GCMSsolution displays a list of files stored to specified projects (folders) in the [Data Explorer] sub-
window. 

Files displayed in the [Data Explorer] sub-window can be moved or copied to other folders, or deleted. 
Tabs are also provided for each file type so that files of the type according to the clicked tab can be 
extracted and displayed. 

When the [Data Explorer] sub-window is not displayed, click [Data Explorer] on the [View] menu. 

No. Name Explanation

1
(Create New Project) button

Creates a new project at the same level of the folder hierarchy 
as the currently referenced project (folder). 
Files can be also copied from the current project when creating 
new projects. 

2
 (Select Project) button

Changes the currently referenced project. 

3 Project in Displays the path of the currently referenced project.
The paths of up to ten recently referenced projects are stored in 
the combo box list. The reference project displayed in Data 
Explorer can be selected and changed from this list.

4 (File View) Displays a list of files contained in the currently referenced 
project.
Double-clicking a file in this list starts up the specific program 
related to that file to load the file. 
Files can be loaded by dragging-and-dropping onto specific 
windows.

5 (Preview) Previews the TIC of a file selected in the file view.

When the preview is not displayed, select [Data Preview] 
on the menu displayed by right-clicking the file view.

6 (File Type Tab) Extracts and displays files of the same type as the selected tab 
from the files contained in the currently referenced project. 

1 2

3

4

5

6



 GCMSsolution Instruction Manual   5

1.2  Common Operations

1

1.2.4 Opening Help

Display and refer to Help when you are not sure of software operations or the terms displayed in a window.

Keyword Search

1 Open Help.

2 Click the [Index] tab.

Keywords can be searched from the entire text of the Help file on the [Index] tab page.

Help Click [Help] in the sub-window.
The Help for the currently open sub-window is displayed.

(Help) Click (Help) on the toolbar. 
[GCMSsolution Help] opens.

[Help] menu Click [Contents] on the [Help] menu. [GCMSsolution Help] 
opens.

[F1] key Press the [F1] key on your keyboard.
The Help for the currently open sub-window is displayed.
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3 Select the keyword in [Title] in the sub-window, and click [Display].

The content of the selected topic is displayed.

When there are multiple matching keywords in multiple topics, the [Topic Found] sub-window opens. 
Select the matching keyword in the list of titles in this sub-window, and click the [Display] button.

1.2.5 Using Online Manuals
When this software is installed, this Instruction Manual, System User's Guide and other online manuals are 
also installed in PDF format. 

1 Double-click the desired instruction manual in the Manual folder in the folder where this 

software is installed. 

Adobe Acrobat Reader starts up and the instruction manual opens.

No. Explanation

1 You can jump to the desired page by clicking the hierarchically structured bookmarks (table of 
contents).

1

3

2
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1.2  Common Operations

1
1.2.6 File Formats

This software handles files in the following formats.

*1 The library is actually composed of multiple files. The constitutive files are somewhat different for 
commercial and private libraries. When copying library files, ensure that all associated files are copied.
Commercial library: .lib, .c2s, .fom, .nam, .ncv, .spc, .str
Private library: .lib, .com, .flg, .fom, .nam, .spc, .add

^ Reference
For details, refer to the instruction manual for the library.

2 You can search for terms that you want to look up.

3 You can jump to the page of the related item by clicking the references or the terms in blue.

No. Explanation

File type Icon Extension File contents

Data file .qgd In addition to the raw data acquired (e.g., chromatograms and spectra), 
the following information is saved.

• Calculation results such as area values and concentrations
• Status information such as the oven temperature and error status at the 

time data is acquired
• Contents of method files used in analysis (including configuration settings 

used for analysis)
• Contents of report format file (when reports are output)
• Contents of batch files (when batch processing is performed)
• Contents of tuning file used in analysis

Method file .qgm Analysis conditions, peak integration parameters, compound tables, etc. 
are saved.
Because the configuration settings are saved when the method is edited, 
the configuration settings are checked when the method file is loaded to 
ensure that they agree with the current settings. Created calibration curves 
are also saved in the method file.

If a method file created in GCMSsolution Ver. 2 is opened in 
GCMSsolution Ver. 4, SIM events are loaded as Q3SIM events and 
scan events are loaded as Q3 scan events. 

Report format 
file

.qgr The report format information used to output a report, such as layout 
information and detailed settings, is saved.
Once a report format file has been created, it can be used repeatedly to 
output reports of the same format.

Batch file .qgb Batch tables used to perform automatic sequential processing are saved.
The same files can be used in both the [GCMS Real Time Analysis] 
program and the [GCMS Postrun Analysis] program.

Tuning file .qgt The conditions used to perform instrument adjustment (tuning) and the 
tuning results are saved.

Tuning files created in GCMSsolution Ver. 2 cannot be opened in 
GCMSsolution Ver. 4 or used for data acquisition. 

Library file .lib *1 These files are used to register the compound information and spectral 
data used to perform similarity searches. 
The libraries consist of public libraries (e.g., NIST and Wiley) and private 
libraries.

Browsing file None .qgq These files store information such as compound information displayed in 
[Quantitative Results View] and the names of method and data files loaded 
in the [Quant Browser] window.

Layout file None .lyt These files store information such as data file names and display layouts 
loaded in [Data Browser].
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1.3 Operation Flow Chart

This section describes a simple operation procedure in GCMSsolution in the form of a flow chart.

Start up GC/MS system 
• Switch the power ON
• Specify maintenance and configuration settings, etc.
• Start up vacuum system 
• Check for vacuum leaks 

^  P.24Execute autotuning 

Qualitative Analysis

1 Create a method file 

• Set instrument parameters. ^ P.31

2 Data Acquisition

• Single run ^ P.46
• ontinuous data acquisition ^ P.55

3 Analyze data  

• Qualitative processing ^ P.82
• Similarity search ^ P.94

4 Print report

• Print graph image. ^ P.97
• Print data reports. ^ P.123

Stop instrument

• Stop vacuum system.
• Turn power OFF.

^  Refer to the GCMS-TQ NX series 
Instruction Manual.

Shut down instrument ^  P.51

• Reduce consumed carrier gas and CID gas.
• Lower column oven temperature.

^  Refer to the GCMS-TQ NX series 
Instruction Manual.
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1.3  Operation Flow Chart

1

Quantitative Analysis

1 Create method file  

• Set instrument parameters. ^ P.31
• Single run using a standard sample ^ P.46

2 Create the Compound Table

  Create the Compound Table using standard sample data
• Create the Compound Table for the MRM/SIM acquisition mode.

Copy from spreadsheet format file to create a table. ^ P.108
• Create the Compound Table for the scan acquisition mode.

Create the Compound Table using the Compound Table Wizard. ^ P.99

3 Continuous data acquisition

Perform continuous data acquisition on standard samples and unknown samples of each 
concentration for calibration curves using the method file used for creating the Compound Table.

• Create the Batch Table. ^ P.55
• Start continuous data acquisition. ^ P.60

5 Reports

• Print graph image.  ^ P.137

4 Quantitation Browser

• Check/correct calibration curves.
^  P.136

• Quantitative calculation of multiple
unknown concentration samples
^ P.135

5 Reports

• Print data reports.
^ P.123

4 Data analysis

• Check/correct calibration curves.
^ P.111

• Quantitative calculation of unknown 
concentration samples.
^ P.115
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2Before Starting Data 
Acquisition

This chapter describes preparations for using the instrument before actually starting data acquisition.

2.1 System Configuration

Register the instrument configuration of the GC to be used for data acquisition together with the 
autosampler, injection unit, column, detector, and other units. Registered details are saved to a system 
configuration file unique to each system, and need not be set each time that GCMSsolution is started up. 
The system configuration file must be set again when the column has been replaced or the instrument 
configuration has been changed. 

2.1.1 Opening the [System Configuration] Sub-Window

1 Start up the [GCMS Real Time Analysis] program, and click the  (System 

Configuration) icon on the [Real Time] assistant bar. 

The [System Configuration] sub-window opens.

No. Name Explanation

1 Available Modules Available instruments are registered. The model name of 
autosamplers, injection units, detectors, additional heaters, and 

additional flows are displayed by clicking  on the left. 

2 Modules Used for Analysis Displays registered instrument configurations for each system. 

3 Moves the instrument selected in the [Available Modules] list to 
the [Modules Used for Analysis] list, and adds the instrument 
as the instrument to be used for data acquisition.

4 Moves the instrument selected in the [Modules Used for 
Analysis] list to the [Available Modules] list, and deletes the 
instrument from the instrument to be used for data acquisition.

5 Properties A detailed setting sub-window of the instrument selected at 
[Modules Used for Analysis] opens.

1 2

3

5

78

4

6
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2.1.2 Checking GC Communication Settings

1 Double-click [Instrument 1] at [Modules Used for Analysis].

The [Instrument] sub-window opens.

6 Print Prints the information of the set instrument configuration and its 
detailed settings. 

7 Set Applies the information of the set instrument configuration and 
its detailed settings, and closes the [System Configuration] sub-
window.

8 Audit Trail Clicking this button opens the [Audit Trail] sub-window. The 
[Audit Trail] sub-window displays the audit trail results until the 
[Set] button was previously clicked. 
To enable the audit trail of the system configuration, click [Audit 
Trail Settings For Config File] on the [Tools] menu in the 
[GCMS Real Time Analysis] program, and select [Input  reason 
when saving Config] in the sub-window that is displayed. 

Once a history is set to be left behind, this setting cannot 
be canceled.

No. Name Explanation
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2.1  System Configuration

2

2 Check the PC-GC communication settings.

When [USB] is selected, enter the serial number of GC in [Serial Number].
When [Ethernet] is selected, enter the IP address of GC in [IP Address].
(The figure below shows the setting example for USB.)

^ Reference
See "A.3.2 Connect the PC to the GC Unit".

2.1.3 Registering Instruments

1 Select the instruments to be used for data acquisition at [Available Modules], and click 

.

The instruments are registered to [Modules Used for Analysis].
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2 Double-click the instrument whose settings are to be changed at [Modules Used for 

Analysis]. 

The sub-window for setting the details of the instrument opens.

3 Set each parameter, and click [OK].

Almost all parameters can be used at their default settings.

[Column] Tab Page
Register several types of columns, and select which one is to be used. Register the information of the 
column to be used, and be sure to select that column.
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2.1  System Configuration

2

[MS] Tab Page
Make sure that the type of MS detector ion source to be used is set correctly. 
When using an MS/MS acquisition mode, such as MRM, Product Ion Scan, Precursor Ion Scan, or 
Neutral Loss Scan, select the [Use CID Gas] checkbox.
When changing the CID gas operating pressure, set the pressure in the [CID Gas (Initial value of tuning)] 
field.
When using the instrument as a single GCMS without using an MS/MS acquisition mode, deselect the 
[Use CID Gas] checkbox. See "2.1.4 Changing CID Gas Settings".
To automatically judge auto-tuning results, select [Check Auto Tuning Result].

^ Reference
See "2.1.5 Setting Criteria for Auto-Tuning Result Judgment".

This setting is available only when the ion source of the MS detector is EI.

When the CID gas operating pressure or CID gas use/non-use setting has been changed, be sure to 
execute auto-tuning before performing data acquisition.

^ Reference
See "2.3.1 Executing Auto-Tuning". 

4 Repeat steps 2 and 3 to set other instruments.

5 When registration is over, click [Set] to close the [System Configuration] sub-window.
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2.1.4 Changing CID Gas Settings
When setting whether or not to use CID gas in data acquisition, follow the procedure below.
When CID gas is set not to be used, data acquisition can be performed in the Q3 scan or Q3 SIM 
acquisition mode with the instrument as a single GCMS.

1 In the [System Configuration] sub-window, set so that CID gas is not used.

1 Start up the [GCMS Real Time Analysis] program, and click the  (System Configuration) icon 
on the [Real Time] assistant bar.

The [System Configuration] sub-window opens.

2 Double-click [MS] at [Modules Used for Analysis]. 

3 When not using CID gas, deselect the [Use CID Gas] checkbox. 

4 Click [OK] to close the [System Configuration] sub-window.

CID gas control is turned OFF, and CID gas no longer flows.
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2.1  System Configuration

2

2 Create a new tuning file, and execute auto-tuning.

When the CID gas operating pressure or CID gas use/non-use setting has been changed, be sure to 
execute auto-tuning before performing data acquisition.

^ Reference
See "2.3.1 Executing Auto-Tuning". 

3 Start data acquisition.

Specify the tuning file obtained by performing auto-tuning by the new CID gas setting, and execute 
data acquisition. 

When CID gas is set not to be used, the following message is sometimes displayed when preparing 
for data acquisition by single run or when continuous data acquisition is started. 

• When data acquisition is started using a method file set with events other than Q3 scan or Q3 SIM 
scan to MS parameters

• When data acquisition is started using a tuning file that has not been tuned after use/non-use of 
CID gas has been changed in the system configuration

^ Reference
Clicking [Help] in the error sub-window displays the error message Help. Remove the cause of the 
error by referring to causes and remedies.
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2.1.5 Setting Criteria for Auto-Tuning Result Judgment
When the ion source of the MS detector is EI, auto-tuning results can be judged automatically. Configure 
the settings using the procedure below.

1 Start up the [GCMS Real Time Analysis] program, and click the  (System 

Configuration) icon on the [Real Time] assistant bar.

The [System Configuration] sub-window opens.

2 Double-click [MS] at [Modules Used for Analysis].

3 To automatically judge auto-tuning results, select [Check Auto Tuning Result].
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2.1  System Configuration

2

4 Click [Test Values of System Check/Auto Tuning] and open the [Auto Tuning] tab page.

Set the criteria for judging auto-tuning results.

5 Click [OK] to close the [System Configuration] sub-window.

Refer to "2.3 Executing Auto-Tuning" to execute auto-tuning.

No. Name Explanation Default

1 FWHM Specifies the upper limit of the shift of the FWHM of spectrum 
peaks at m/z 69, 219, and 502 from the set value.

0.1

2 Detector Gain Specifies the upper limit of the detector voltage set by auto-tuning.

Although the detector voltage on the actual instrument is a 
negative value, the software handles the parameter as a 
positive value.

2

3 Vacuum Leak 
(Intensity Ratio of 
69/28)

Specifies the lower limit of the intensity ratio between m/z 69 
(PFTBA) and m/z 28 (Nitrogen).

• The reference value of the criteria differs depending on 
the pretreatment unit. Set the criteria in accordance with 
the pretreatment unit by following the values below.

• Pyrolyzer, OPTIC-4: intensity ratio 1

• Other pretreatment units: intensity ratio 2

• When using the advanced flow technology system (such 
as detector splitting system or backflush), the intensity 
for m/z 28 may be larger than when using the standard 
system. Therefore, it is not recommended to select 
[Vacuum Leak (Intensity Ratio of 69/28)] for check.

2

4 Maximum Mass 
Shift

Specifies the upper limit of the mass axis shift. 0.1

5 Relative Intensity 
Ratio for High 
m/z (502)

Specifies the lower limit of the relative intensity for m/z 69 in the 
high mass range (m/z 502).

2

ZStanius
Highlight

ZStanius
Typewriter
1.1.6.2

ZStanius
Highlight
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2.2 Executing a System Check

The system check judges whether or not there are problems in the instrument status. It is recommended 
that a system check is executed before the series of data acquisition operations are begun. 

2.2.1 Opening the [System Check] Sub-Window

1 Start up the [GCMS Real Time Analysis] program, and click [System Check] on the 

[Instrument] menu. 

The [System Check] sub-window opens.

1

2

3

4

67 5
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2.2  Executing a System Check

2

No. Name Explanation

1 Check Select the items to be checked. The operation time/number of 
uses of consumables and instrument status are checked. 

Maintenance Checks the operation time/number of uses of GC and MS 
consumables and maintenance parts. 
If the result of the check is "Fail," replace the consumables and 
reset operation status. 

GC Check Checks the status of the GC system. 
Fail:
If repair or adjustment is required, contact your local Shimadzu 
representative. 
Replace any parts that need replacing.

GC system check criteria can be set by clicking [Rough 
Standard for Exchange] in each of the instrument property 
sub-windows of the [System Configuration] sub-window. 
These values are merely for reference and are not 
manufacturers' guaranteed values. 

MS Check Checks setting values relating to MS data acquisition precision. 
Fail:
If repair or adjustment is required, contact your local Shimadzu 
representative. 
Replace any parts that need replacing or perform auto-tuning if 
required. 

MS system check criteria can be set by clicking [Test Value 
of System Check] in each of the instrument property sub-
windows of the [System Configuration] sub-window. 

These values are merely for reference and are not 
manufacturers' guaranteed values. 

2 Run Executes the system check.

3 View Result Displays the check results in the [System Check Result] sub-
window.

4 Advanced Sets GC and MS detailed check items. 

This item can be set only when a user with [Modify system 
check settings] rights is logged in. 

Some items can be executed only when EI is selected as 
the ion source. Also, some items can be executed only 
when the MS has finished starting up. Items that cannot be 
executed are grayed out.

5 Run Auto Tuning As Needed /
Run Auto-tuning

When [Run Auto Tuning As Needed] is selected, auto-tuning is 
executed when one of the [Signal Intensity Ratio], [Maximum 
Mass Shift] and [FWHM] MS check items is judged as "Fail." 
When [Run Auto-tuning] is selected, auto-tuning is executed 
regardless of the system check results. 

• Auto-tuning conditions can be set by clicking the  

(Auto Tuning Condition) icon on the [Tuning] assistant 
bar in the [Tuning] window. Execution of auto-tuning 
using defaults is recommended. 

• When auto-tuning is executed, previously made 
calibration curves sometimes can no longer be used. 

6 Report Out Automatically prints a result report after the system check is 
executed. 
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2.2.2 Executing a System Check

1 Set the system check items, and click [Run]. 

The system check is started. During execution, the time elapsed is incremented and the progress bar 
advances. 
When the check ends without any problems, "Pass" is displayed above the progress bar. 
If a problem is found in the result, "Fail" is displayed. 

2 To check the system check results, click [View Result]. 

The [System Check Result] sub-window is displayed.

7 (Progress bar) Indicates the progress of the system check.

No. Name Explanation
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2.3  Executing Auto-Tuning

2

^ Reference
When the system check result is [Fail], click [Help] and refer to GC check and MS check topics. 

• The system check results are saved to a file named in accordance with the following rule at 
\Systemcheck\Log in the folder where GCMSsolution is installed:
System No._YYYYMMDDHHMM.qgc
To check the results of system checks executed so far, click [Load] in the [System Check Result] 
sub-window, and select the file with the date of the result to be checked. 

• The [Reset Consumables] sub-window is displayed by clicking the [Reset] button that is displayed 
when [Advanced] is clicked. 
When a consumable is replaced, reset the operation time or number of uses. 

2.3 Executing Auto-Tuning
There are two ways to tune the MS control parameters, auto-tuning (automatic adjustment) and 
tuning by [Peak Monitor] (manual adjustment). 

Auto-tuning automatically adjusts the MS control parameters in accordance with the auto-tuning 
conditions so that desirable spectrum peaks can be acquired. 

Peak monitor directly changes and tunes the individual control parameters of the instrument while 
observing the mass peaks. 

This is used, for example, to check for any vacuum leaks. 

This section describes auto-tuning.

^ Reference
When the ion source of the MS detector is EI, auto-tuning results can be judged automatically.

See "2.1.5 Setting Criteria for Auto-Tuning Result Judgment".
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2.3.1 Executing Auto-Tuning

1 Click the  (Tuning) icon on the [Real Time] assistant bar in the [GCMS Real Time 

Analysis] program.

The [Tuning] window opens.

2 To create a new tuning file, click [New Tuning File] on the [File] menu. 

When the ion source of the MS detector is EI, the [Select Tuning Mode] sub-window opens. Select the 
tuning mode according to the concentration of the component to be measured, and click [OK]. 
Measurement can be performed by the appropriate dynamic range since the tuning file is created by the 
emission current matched to the selected mode. 

Set 20 uA, 60 uA or 150 uA as the emission current when [High Conc.], [Normal] or [High Sens.] is 
selected, respectively. 

When using an existing tuning file to perform tuning, click [Open Tuning File] on the [File] menu to 
display the [Open Tuning File] sub-window. Then, select the desired tuning file, click the [Open] 
button, and proceed to step 5. 

3 Click the  (Auto Tuning Condition) icon on the [Tuning] assistant bar. 

The [Tuning Information] sub-window opens.
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2.3  Executing Auto-Tuning

2

4 Set the items to auto-tune and their auto-tuning conditions, and click [OK]. 

Execution of auto-tuning using default settings is recommended. 

5 Click the  (Start Auto Tuning) icon on the [Tuning] assistant bar. 

The [Auto Tuning] sub-window is displayed, and auto-tuning is started. In the [Auto Tuning] sub-
window, you can check the tuning status.

By default, auto-tuning will be performed with CID gas turned ON and then OFF when the [Use CID 
Gas] checkbox is selected.

When the [Print Result after Auto Tuning] checkbox on the [Tuning] menu is selected, a tuning report 
will be printed after auto-tuning ends. 
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6 Click [Save Tuning File As] on the [File] menu, and enter the tuning file name to save the 

file.

2.3.2 Checking Tuning Results

1 Click the  (Tuning Result View) icon on the [Tuning] assistant bar. 

The tuning results are displayed in the [Tuning] window.

No. Name Explanation

1 Ion Source The ion source currently set in the system configuration is 
displayed. 
When the ion source is NCI, buttons for switching display of the 
tuning results for each of the NCI, SEI and SCI ionization 
modes are displayed.

2 Tuning Date Displays the date and time that tuning was performed.

3 Acquisition Mode Select the acquisition mode for displaying the tuning results. 

4 CID Gas Displays the tuning results for the CID gas status (ON/OFF) 
selected here.

5 Q1 Resolution
Q3 Resolution

Select the resolution of Q1 or Q3 at SIM measurement. 
Selectable items change according to the acquisition mode. 
^ Reference

For details, refer to Help.

7

1 4 3

6

2 5 8
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2.3  Executing Auto-Tuning

2

When the [Tuning] window is opened, the previously saved tuning file or the tuning file used in the 
previous data acquisition is automatically loaded. Unless otherwise specified, the tuning file loaded 
here is used in system checks or in data acquisition.

6 [MS] tab page
[GC] tab page

The [MS] tab page displays the MS monitor values that indicate 
instrument status during tuning and the MS control parameters 
saved to the tuning file. 
The [GS] tab page displays the GC instrument status (column 
information, temperature, pressure, flowrate) during tuning.

7 [Peak Profile] tab page
[Spectrum] tab page

The [Peak Profile] tab page displays the peak profile and 
spectrum for a specific m/z of the standard sample (PFTBA) 
that was acquired when tuning was performed. 
The [Spectrum] tab page displays the spectrum of the standard 
sample (PFTBA) that was acquired when tuning was 
performed. 

8 Judgment result display Displays the result of auto-tuning judgment at the Q3 scan with 
CID gas set OFF when auto-tuning results are set to be judged 
in the System Configuration.

No. Name Explanation
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2.3.3 Printing Tuning Reports

1 Click the  icon on the toolbar. 

The tuning results are output to the printer.

^ Reference
When turning results are not set to be judged in the System Configuration, check the auto-tuning 
results using the procedure below.

1 Check that the FWHM (full width at half maximum) values are in the range 0.5 to 0.7.

2 Check that the detector voltage does not exceed 2 kV.

3 Check that the relative intensity ratio for m/z 502 is at least 2 %.

4 Check that the peak intensity for m/z 69 is at least twice that for m/z 28.

If any irregularities are discovered above, possible causes could include a vacuum leak, poor 
column connections, or contaminated ion source. Remedy the problem by referring to the 
maintenance Help (MS Navigator) that is displayed by clicking [Maintenance] on the [Help] menu in 
the [GCMS Real Time Analysis] program. 

2

1

34
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3Data Acquisition

This chapter describes how to use the instrument to set the data acquisition parameters and perform a 
single run. 

3.1 Flow of Data Acquisition
1. Create a method.
Set the operating conditions for the GC, MS, autosampler, and other units. If a method file is already 
created, check its content. 

^ Reference
See "3.3 Setting Data Acquisition Methods".

2. Register the sample.
Register the sample name, sample ID, data file name, and other information.

^ Reference
See "3.4.1 Registering Samples".

3. Inject sample and perform data acquisition.
Ready the instrument for data acquisition, inject the sample manually or automatically, and start data 
acquisition.

See "3.4.2 Preparations" and "3.4.3 Starting Single Run". 

4. Complete acquisition
Acquired data is saved and data acquisition is complete. 

^ Reference
For details on data processing from here on, see Chapters "5 Postrun Analysis" and "8 Reports"

Operations from data acquisition through to data processing can be also performed automatically. 
See "4 Continuous Data Acquisition".

3.2 [Acquisition] Window

The [Acquisition] window has views for displaying sample information, chromatograms and spectra, and 
[Instrument Parameters View] for displaying and setting the parameters of each instrument. 

3.2.1 Opening the [Acquisition] Window

1 Start up the [GCMS Real Time Analysis] program, and click the  (Data Acquisition) 

icon on the [Real Time] assistant bar. 

The [Acquisition] window opens.
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Set the display proportion of [Chromatogram View] and [Spectrum View] and the status curve of the 
instruments to display in [Chromatogram View] on the [Display Settings] sub-window that appears by 
selecting [Display Settings] on the [View] menu.

No. Name Explanation

1 Sample information Displays the sample name, sample ID, and data comment. 
Items displayed at the sample information view are set on the 
[Setting 3] tab page in the [Display Settings] sub-window that is 
displayed by clicking [Display Settings] on the [View] menu. 

2 Chromatogram View Displays the chromatogram acquired on the instrument in real 
time. Oven temperature, carrier gas flow rate, and other 
information can also be displayed overlaying chromatograms. 
When performing acquisition on two lines, the chromatogram of 
each detector is displayed.

3 Spectrum View Displays the MS spectrum acquired on the instrument in real 
time. 
Displays the spectrum obtained by measurement using the 
data acquisition conditions of event 1. 

4 Instrument Method View Sets the data acquisition conditions (method) of the GC, MS, 
autosampler, and other units. 
When 2 lines are set in the system configuration, set the 
instrument parameters for each line. Switch the line by using 
the [Select Line] button.

5 Instrument Monitor Displays each of the parameters of the analytical instrument in 
real time. Currently, this is used for judging whether or not the 
instrument can start data acquisition immediately. 
When 2 lines are set in the system configuration, set the 
instrument parameters for each line.

2 3 4 51
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3.3  Setting Data Acquisition Methods

3

3.3 Setting Data Acquisition Methods

Set the parameters to be used for data acquisition in [Instrument Parameters View]. Parameters that are 
set are saved to a method file. 

This section describes how to set the parameters in [Instrument Parameters View]. 

3.3.1 Creating New Method Files

1 Click [New Method File] on the [File] menu. 

The [Setting Options] sub-window opens by clicking [Option] on the [Tools] menu. Selecting [Prompt 
on File New] in the [Method File] area on the [File New] tab page allows you to use a template file 
when creating a method file.

GCMSsolution includes method template files suitable for frequently used acquisition modes, as 
shown below. Setting items on MS Tables that are not used in some acquisition modes are hidden in 
method template files. 
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• If [Instrument Parameters View] is not displayed, click the  (Method Detail) icon on the 

[Acquisition] assistant bar.

• To open an existing method file, drag-and-drop the method file onto the [Acquisition] window from 
the [Method] tab page in the [Data Explorer] sub-window. 

3.3.2 AOC Instrument Parameters
Set the injection conditions when using the autosampler to inject samples. 
This sub-window is displayed when an autosampler is registered at [Modules Used for Analysis] in the 
system configuration. 

1 Click the [Sampler] tab, and set the autosampler parameters.

Set the parameters in more detail in the [Advanced] sub-window that is displayed by clicking 
[Advanced]. Normally, data acquisition can be performed at the default settings. 

^ Reference
For details about each of the parameters, refer to Help.
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3.3  Setting Data Acquisition Methods

3

3.3.3 GC Instrument Parameters
Set the gas chromatograph (GC) operating conditions.

1 Click the [GC] tab.

2 Set the parameters.

 [Injection Port] window

1 Click the injection unit from the unit tree used.

2 Set the temperature of the injection unit taking the boiling point of the target component into 
consideration.

3 Select the injection mode.

• Select split mode when there is a large volume of target component to inject. (Amount of 
target component: 10 ng to 100 ng min.)

• Select splitless mode when there is a small volume of target component to inject. (Amount of 
target component: less than 10 ng)

4 Set the carrier gas.

^ Reference
For details about each of the parameters, refer to Help.

5 Create flow rate and pressure programs so that the target component separates from other peaks.

1 3 4 52
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 [Column] window

1 Click the column unit from the unit tree used.

2 Set the initial temperature of the column oven.

3 Create a column oven temperature program so that the target component separates from other 
peaks.

1 32
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3.3  Setting Data Acquisition Methods

3

 [General] window

When varying the parameters for controlling the GC by time during measurement, set a prerun program 
or a time program.

1 Click the general unit from the unit tree used.

2 At [Time], enter the retention time during which processing is executed, and at [Device], select the 
unit on which processing is executed.

At [Event], select the processing event.

Set values for processing at [Set Value], if required.

• A "prerun program" is a time program for controlling each unit before data acquisition.

• A "time program" is a time program for controlling each unit during data acquisition.

1 2
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3.3.4 MS Instrument Parameters
Set the mass spectrometer (MS) operating conditions. 

There are also other ways of setting MS tables. Refer to the following sections.

^ Reference
• "3.3.4.1 Creating MS Tables Based on Compound Tables"

• "3.3.4.2 Creating FASST Measurement Methods"

• GCMS Operation Guide - Basic Operation Guide

• GCMS Operation Guide - Method Development Guide

1 Click the [MS] tab.

2 Set the MS parameters.

No. Name Explanation

1 Instrument parameters Sets the ion source temperature, interface temperature, 
detector voltage, and other parameters.
^ Reference

For details about each of the parameters, refer to Help.

2 MS Table Set detailed data acquisition settings for each event. 
The group No. and event No. of events are indicated joined by 
a hyphen "-" on the left edge of the table. If the start time and 
end time of adjacent events are each set to the same value, the 
events will automatically belong to the same group. 
Select the acquisition mode from the following eight modes:
MRM, Product Ion Scan, Precursor Ion Scan, Neutral Loss 
Scan, Q3 Scan, Q3 SIM, Q1 Scan or Q1 SIM
^ Reference

Available parameters differ according to the acquisition 
mode. For details, refer to Help.

Up to 128 groups can be registered to one method file. Up 
to 64 events can be registered to one group. The 
maximum total number of events for all groups is 2048 in 
the case of SIM type events and 128 in the case of scan 
type events. 

1 2
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Wit this instrument, data acquisition settings can be successively switched during a single data 
acquisition. Each data acquisition setting is called an "event". When multiple events have been set to 
the same measurement time range (group), operation switches to the data acquisition settings of the 
next event after the event time set to each event has elapsed. When measurement of the last event 
ends, operation returns to the data acquisition settings of the first event. 

In the example below, for ten minutes starting from one minute, data acquisition is performed in the 
order event 1 ->  event 2 ->  event 3 ->  event 1 ->  event 2 ->  event 3  and so forth. The cycle from 
event 1 to event 3 is called Loop. For 20 minutes starting from ten minutes, data acquisition is 
performed in the order event 1  -> event 2 ->  event 1 ->  event 2  and so forth. 

MS Table Setting Example (MRM Acquisition Mode)
Set the parameters for measuring by SIM for both Q1 and Q3. 

1 Hide unwanted columns in the MS Table, and set the number of ions (i.e. number of channels) to be 
measured. 

The [Table Style] sub-window opens by right-clicking on the MS Table, and clicking [Table Style] on 
the displayed menu. 

In this sub-window, hide unwanted columns and set the number of channels to display in the MS 
Table at [Number of Ch]. 

2 3 4 5 6 7
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2 At the row of the event to be set, set the compound name of the component to be measured. For 
events in the MRM acquisition mode, set the data acquisition settings of one component per one 
event. 

3 Set the time that data acquisition will start after the sample is injected, and set the time that data 
acquisition will end. 

4 Click the [Acq. Mode] cell, and select [MRM] from the list that is displayed. 

5 At the [Event Time] cell, set the time that spectral data will be acquired at each event. 

6 Set the m/z of the precursor ion and the m/z of the product ion that is acquired by destruction of the 
precursor ion on each channel. 

Enter in the format "precursor ion m/z > product ion m/z". Up to 16 ions can be set. 

7 Enter the collision energy of the channel. 

3 Repeat steps 1 through 6 to set the other components.

Acquire Data without Using CID Gas(Q3Scan)

Even when the option of using CID gas is selected for the system configuration, selecting the [Acquire Data 
without Using CID Gas(Q3Scan)] checkbox enables data acquisition in Q3 Scan and Q3 SIM modes with 
CID gas turned OFF. Without effects of CID gas, better spectrum peaks can be acquired.

This function is valid only in Q3 Scan or Q3 SIM acquisition mode.

However, when an MS/MS acquisition mode (MRM, Product Ion Scan, Precursor Ion Scan, or Neutral Loss 
Scan) is included in the MS table, CID gas will not be turned OFF even with the [Acquire Data without Using 
CID Gas(Q3Scan)] checkbox selected.

This parameter can be selected only when the option of using CID gas is selected for the system 
configuration.
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MS Program

When varying the parameters for controlling the MS by time during measurement, set the MS program.

1 Select the [Use MS Program] checkbox, and click [Set].

2 Make an MS program, and click [OK].

1 At [Time (min)], enter the retention time during which processing is executed, and at [Command], 
select processing content. 

Set values for processing at [Value], if required. 

2 Click [OK].

• The [GCMS Data File Open] sub-window opens by clicking the [Load Chromatogram] button. 
When the data file is selected and [Open] is clicked, the TIC of that data file is displayed.

• When a chromatogram is clicked with the [Time (min)] cell selected, the retention time for the 
clicked part of the chromatogram is set to the cell. 

1 2
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3.3.4.1 Creating MS Tables Based on Compound Tables
This section describes how to copy data acquisition settings, which are set to spreadsheet format files 
(e.g. Excel) that are preset with data acquisition settings, to Compound Tables, and use COAST to create 
MRM/SIM events for MS parameters based on the Compound Table. 
COAST is used to create MS Tables for MRM or SIM measurement. 
The MS Table for measuring one compound per event can be created. 

1 Copy the data acquisition settings of the spreadsheet format file to the Compound 

Table. 

1 Select and copy the content in the spreadsheet format file.
Make sure that the columns in the compound table and in the spreadsheet format file are arranged in 
the same order.

2 Click [Quantitative Parameters] on the [Method] menu in the [Acquisition] window, and click the 
[Compound Table] tab in the [Quantitative Parameters] sub-window that is displayed. 

3 Click at the start of the row in the Compound Table to copy, and select [Paste] on the right-click 
menu. 
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Rows are automatically added, and the content is pasted.

4 Click [OK] to close the [Quantitative Parameters] sub-window. 

The screen returns to the [Acquisition] window.

2 Use COAST to create the MS Table based on the Compound Table. 

1 Click [Creation of Automatic MS Table [COAST]] on the [Method] menu. 

The [Creation of Automatic MS Table [COAST]] sub-window is displayed.

The retention time set to the Compound Table and the MRM/SIM Table with components divided into 
measurement groups based on the processing time of peak integration parameters are displayed at 
the bottom of the sub-window. 

2 Adjust the end time so that there are 20 channels or less for each group. 
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When there is a group division where peaks are closely concentrated, set the end time so that 
there is a gap between peaks. 
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3 Click [OK].

An MS table is created with one compound assigned to one event. 

At this time, the event numbers of the Compound Table are also set.

3.3.4.2 Creating FASST Measurement Methods
FASST (Fast Automated SCAN/SIM Type) measurement refers to switching between the scan acquisition 
mode and MRM (or SIM) acquisition mode in a single measurement group. 
The purpose of FASST measurement is broadly classified into two types. 
Scan measurement is suited to qualitative analysis of components since mass spectra over a broad range 
can be obtained. This is also used for quantitative analysis since components can be identified more 
reliably than by MRM/SIM measurement. Yet, the difference in sensitivity required for each component 
increases as the number of target components to be batch-analyzed increases, with the result that 
sensitivity is sometimes insufficient by scan measurement. In cases such as this, high-sensitivity data 
acquisition is possible by performing FASST measurement on components that require higher sensitivity. 
Also, by scan measurement, elution of unknown components can be checked from the mass spectra of 
masses that have not been measured by MRM/SIM measurement. 
This section describes how to create a method file for FASST measurement from a Compound Table 
when a method file for MRM/SIM measurement is already available. 

1 In the [Acquisition] window, open the method file for MRM/SIM measurement. 

2 Click [Creation of Automatic MS Table [COAST]] on the [Method] menu. 

The [Creation of Automatic MS Table [COAST]] sub-window is displayed.
The retention time set to the Compound Table and the MRM/SIM Table with components divided into 
measurement groups based on the processing time of peak integration parameters are displayed at the 
bottom of the sub-window. 
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3 Select [FASST] at [Select Data Acquisition Mode], select the [FASST] column 

checkboxes of the compounds to undergo FASST measurement. Click [Update Table].

4 If necessary, change the end time setting of the group. 

5 Click [OK] to complete COAST. 

An MS Table set with FASST measurement events is created. 

• Quantitation is performed to the compounds whose [FASST] column checkboxes are not 
selected.

• The measurement mass range and event time for scan measurement events are automatically 
set. Confirm the [Start m/z], [End m/z], and [Scan Speed] in the MS Table, and if necessary, 
change the settings for the measurement mass range and event time. If [Start m/z], [End m/z], 
and [Scan Speed] are not displayed in the MS Table, select [Table Style] on the right-click menu 
on the MS Table, and add them to the display items.
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3.3.5 Saving Method Files

1 Click [Save Method File As] on the [File] menu. 

The [Save Method File As] sub-window opens.

2 Select the folder to save the method file in, enter a file name, and click [Save]. 

Specified parameters are saved as a method file. 
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3.4 Starting Single Run

There are two ways of acquiring data, by single run (data acquisition executed only once) or by continuous 
data acquisition (data acquisition performed continuously from multiple samples). 

This section describes how to perform single run acquisition.

3.4.1 Registering Samples
Before executing single run, set the name or ID of the sample to be used for data acquisition, data file 
name to save acquired data to, vial No., report settings, format file name, and other settings. 

Click [Advanced] to configure the report settings and format file name.

1 Click the  (Sample Login) icon on the [Acquisition] assistant bar. 

1 Enter the data file name.

• When only the file name is entered, the sample is saved to the same folder as the method file 
open in the [Acquisition] window. 

• To prepare for data acquisition when a data file of the same name already exists, a 
confirmation sub-window is displayed to prompt whether to overwrite the file or automatically 
rename the file. 

2 Enter the position of the sample vial.

When "0" or "-1" is set, data acquisition is performed without samples being injected from the 
autosampler. 

3 Enter the sample injection volume.

1

2
3
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3.4.2 Preparations
Download the [Instrument Parameters View] parameters to the instrument to ready it for data acquisition. 

1 Click the  (Download) icon on the [Acquisition] assistant bar. 

• When the  (Download) icon is clicked without the parameters set at [Instrument 

Parameters View] saved to a method file, a message box for selecting whether or not to save 
the currently set method to the method file will be displayed. 

To save the method file, click [Yes]. If the method file is opened and edited, it will be 
overwritten. Otherwise, the [Save Method File As] sub-window opens. Select the folder, enter 
the name of the method file, and save the file.
To ready the system without saving the method file, click [No]. At this time, too, the set 
parameters are downloaded to the instrument. 
To cancel readying of the instrument, click [Cancel]. 

• When a sampler is connected to the instrument, single run is automatically started if the GC 
status after it is readied for data acquisition is [Ready]. 

3.4.3 Starting Single Run
Start single run data acquisition.

1 When a sampler (AOC or HS) is not connected to the instrument, click the  (Start) 

icon on the [Acquisition] assistant bar. 

During data acquisition, the chromatogram and spectrum are displayed, and the status of [Instrument 
Monitor] is [Run]. 
When data acquisition ends, the status of [Instrument Monitor] returns to [Ready]. 

• Data acquisition ends when the GC program time or the MS measurement time set to the method, 
whichever is longer, elapses. 

• Data acquisition can be also started by pressing the [START] button on the GC unit. The same 
applies when a sampler is connected. 

While the [GCMS Real Time Analysis] program is in operation, do not insert or remove devices (e.g. 
flash memory, printers) connected on the USB interface or turn the power ON/OFF. Doing so might 
impede communications with the instrument. 
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3.4.4 Stopping Single Run
Stop single run data acquisition.

1 Click the  (Stop) icon on the [Acquisition] assistant bar. 

Caution

When the  (Stop) icon is clicked to stop measurement midway, the MS program stops at that 

point, but the GC program does not stop. This is to prevent sample from remaining in the column. If 
it is OK to stop GC operation, press the [STOP] button on the GC unit. 

3.4.5 Extending the Data Acquisition Time
The time may be extended during data acquisition.

This section describes how to extend the data acquisition time.

1 Click [Extend] on the [Acquisition] menu. 

2 Enter the extended time for both GC and MS in minute increments. 

The data acquisition time can be extended only when one event is set in one group to MS 
parameters and when one of the Q3 Scan, Q1 Scan, Product Ion Scan, Precursor Ion Scan, or 
Neutral Loss Scan acquisition modes is selected. 
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3.4.6 Snapshot
Data obtained so far since start of measurement can be displayed and analyzed during data acquisition. 

1 Click the (Snapshot) icon on the [Acquisition] assistant bar. 

Data obtained so far since start of data acquisition are displayed in the [Data Analysis] window. 

2 Analyze the data in the [Data Analysis] window. 

3 To load acquired data from a continuing data acquisition after snapshot has been 

executed, click  (Update) on the toolbar in the [Data Analysis] window. 

The latest data are displayed in the [Data Analysis] window. 
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3.5 Monitoring Instrument Status

This section describes how to monitor the current status of the instrument.

3.5.1 Instrument Monitor
[Instrument Monitor] displays the status of instruments and the measured values of various parameters. In 
the [Monitor Settings] sub-window, parameter settings can be changed without changing the instrument 
methods in the method file. 

No. Name Explanation

1 Instrument status The color changes according to the current status of the GC, 
MS and HS. 
^ Reference

For details, refer to Help.

2 Line1/Line2 Switches the line to be monitored. 
This item is displayed only when 2 lines are set in the system 
configuration.

3 Units Monitors the information of units on the selected line. 

4 Vacuum Displays the vacuum level as a graph. The triangular mark 
moves according to the measured values. [H.Vac.] is not 
displayed when the ion gauge is set to [Ion Gauge] in the 
system configuration. 

5 GC Consumables
MS Consumables

The color of these items changes according to the degree of 
consumption. 
^ Reference

For details, refer to Help.

6 Detail Clicking this item opens the [Monitor Settings] sub-window. 
Here, units' measured values and settings for other 
parameters, and the current status and estimated replacement 
time of consumables can be checked. 
^ Reference

For details, refer to Help.

1

2

3

4

5

6

7



 GCMSsolution Instruction Manual   51

3.6  Ecology Mode

3

3.6 Ecology Mode
The ecology mode can be used to reduce power consumption or consumed carrier gas and CID gas 
when the instrument is standing by for data acquisition. When the instrument enters the ecology mode, 
the shutdown method is downloaded to the instrument. When the ecology mode is canceled, the 
instrument is returned to the mode before it entered the ecology mode. There are two ways of entering 
the ecology mode, manual and automatic. 
This section describes manual operations.

^ Reference
For details on how to automatically enter the ecology mode, see "4.6 Entering the Ecology Mode 
after Continuous Data Acquisition".

3.6.1 Setting the Ecology Mode

1 Click [Ecology Settings] on the [Tools] menu in the [Acquisition] window. 

2 Set the content of the ecology mode, and click [OK].

1  To download the shutdown method file to the instrument, select the [Shutdown Method File] 
checkbox, and specify the name of the method file. 

To edit the parameters of the shutdown method file, click the [Edit] button. 

This starts up the [GCMS Analysis Editor] program, and the method file is loaded to the 
[Acquisition] window. After parameters have been edited, save the method file. 

7 Ecology Mode Units can be turned OFF and carrier gas flow rate can be 
reduced when the instrument is standing by for data 
acquisition. The original status is automatically returned to after 
the ecology mode is canceled. 

No. Name Explanation

1

2
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2 Click the button of the line for the parameters in the shutdown method file to download to the 
instrument. 

3 Select the parameters to download to the instrument, and click [OK]. 

4 To control the unit when the instrument enters the ecology mode, click the button for the line 
corresponding to the unit.  

3

4
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5 Select the checkboxes of the commands to download to the instrument, and click [OK]. 

6 In the [Ecology Settings] sub-window, and click [OK].

3.6.2 Entering the Ecology Mode

1 Click the  (Ecology Mode) button at [Instrument Monitor] in the [GCMS  Real Time 

Analysis] program.

This button cannot be clicked while data acquisition, tuning and system check are in progress or 
while the instrument is starting up or is shutting down. 

2 A message confirming whether or not to enter the ecology mode is displayed. Click 

[Yes]. 

The ecology settings are downloaded to the instrument, and the instrument enters the ecology mode. 

 While the instrument is in the ecology mode, the [Ecology Mode] sub-window is displayed, and other 
sub-window operations in the [GCMS Real Time Analysis] program are not possible until the ecology 
mode is canceled.

5
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3.6.3 Canceling the Ecology Mode

1 In the [Ecology Mode] sub-window, click [Cancel]. 

When the ecology mode is canceled, the instrument returns to the mode before it entered the ecology 
mode. 

3.6.4 Setting the PC or Display to the Power Save Mode
To set the ecology mode when the PC or display is not in use, set the mode in the Windows power 
options. 

• The instrument will not automatically switch to the power save mode while the instrument is 
running. The instrument will switch to the power save mode after the current process is finished 
and a specified amount of time elapses. 

• The power save mode can be activated manually, depending on power option settings. However, 
do not manually switch to the power save mode while the instrument is running. Doing so will 
cause an error communicating with the instrument. 

• This feature is not compatible with pretreatment units other than HS-20 or AOC-20. 
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4Continuous Data 
Acquisition

Continuous data acquisition refers to data acquisition performed continuously on multiple samples. To 
perform continuous data acquisition, first start by making a Batch Table. 

4.1 Opening the [Batch Table] Window

1 Start up the [GCMS Real Time Analysis] program, and click the  (Batch Processing) 

icon on the [Acquisition] assistant bar. 

The [Batch Table] window opens.

4.2 Creating Batch Tables

To acquire data continuously from multiple samples, set the sample information, vial #, method file, and 
data file name to a Batch Table. 

This section describes how to create a Batch Table.

4.2.1 Batch Table Wizard
Batch Tables can be made easily by using the Batch Table Wizard.

1 Click the  (Wizard) icon on the [Batch] assistant bar.

The [Batch Table Wizard] sub-window opens. Set the following parameters.

1 Click [New] at [Batch Table]. 

To add a row to the currently displayed batch file, click [Append].

1
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2 Set the data acquisition pattern for the standard sample and unknown sample.

This description is for an example of how to create a Batch Table used to perform data acquisition on 
both a standard sample and unknown sample. 

3 Set [Method File] to be used for continuous data acquisition. 

4 Set whether to perform quantitative processing or qualitative processing on the data. 

5 When settings are finished, click [Next]. 

The [Batch Table Wizard Standard Sample (1)] sub-window opens. 

2 Set the standard sample information. 

This sub-window is displayed only when the sample type is set to [Standard & Unknown] or [Standard 
Only] in the previous sub-window. 

1 Enter [Vial #] where injection of the standard sample will begin.

2 Set [# of Calib. Levels] and [Average Count] that injection is performed from the same vial.

3 Set the injection volume.

4 Enter [Sample Name] and [Sample ID] of the standard sample. 

When [Auto-increment] is selected, [Sample Name] and [Sample ID] will automatically be assigned 
to a continuous number. 

5 Click [Next]. 

The [Batch Table Wizard Standard Sample (2)] sub-window opens. 

1
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6 Enter [Data File Name].

To automatically generate a data file name, select [Auto-increment]. 

Set the format of the data file name on the [Data Filename] tab page in the [Settings] sub-

window that is displayed by clicking the  (Settings) icon on the [Batch] assistant bar. 

Batch Table settings matching [Selected Items] are joined by a hyphen "-," and are appended a 
continuous number in accordance with the number assignment rule selected at [Auto-increment 
Format]. 

7 To print a report, select [Report Out], and set the report format file name. 

^ Reference
To create a new report format, refer to "8.2 Creating Report Formats".

8 Click [Next]. 

The [Batch Table Wizard Unknown Sample (1)] window opens. 

6
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3 Set the unknown sample information in the same way as the standard sample.

1 Enter [Sample Name] and [Sample ID] of the unknown sample.

When [Auto-increment] is selected, [Sample Name] and [Sample ID] will automatically be assigned 
to a continuous number. 

2 Click [Next]. 

The [Batch Table Wizard Unknown Sample (2)] window opens. 

3 Enter [Data File Name].

To automatically generate a data file name, select [Auto-increment]. 

4 To print a report, select [Report Out], and set the report format file name. 

^ Reference
To create a new report format, refer to "8.2 Creating Report Formats".

5 When settings are finished, click [Finish]. 

The [Batch Table Wizard] sub-window closes, and the Batch Table is created.

If there are values other than those in the Wizard that require setting, directly edit the Batch Table.
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4.2.2 Editing Batch Tables
In daily data acquisition, partially editing and executing an existing batch file is handy. This section 
describes an example of how to batch-edit specified rows based on the vial #, sample name, data file 
name, and other information of pre-edited rows. This section describes two functions, [Fill Series] and [Fill 
Down], that are often used for directly editing Batch Tables.

Appending Settings with a Continuous Number

The [Vial#], [Sample Name], [Sample ID], and [Data File] items in the Batch Table are assigned a 
continuous number. 
This section describes how to assign a continuous number to [Vial#]. 

1 Drag-and-drop the batch file from the [Batch] tab page in the [Data Explorer] sub-

window onto the [Batch Table] window. 

2 Edit the vial No. of the first row to set with a continuous number. 

3 Right-click the edited cell, and click [Fill Series]. 

The vial numbers, and the numbers appended to sample names and data file names will be set with a 
continuous number. 
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[Fill Series] can be also executed for the selected range of cells.

Copying Settings

Settings can be copied to each individual column of a Batch Table.
This section describes how to copy and set [Sample Name].

1 Enter [Sample Name] of the first row.

2 Right-click the cell at the first row of the [Sample Name] column to copy, and click [Fill 

Down]. 

The content of the first row will be copied to all cells. 

[Fill Down] can be also executed for the selected range of cells.

4.3 Starting Continuous Data Acquisition

This section describes how to start and stop continuous data acquisition, pause continuous data 
acquisition to edit the Batch Table, and partially execute continuous data acquisition. 

4.3.1 Starting Continuous Data Acquisition

1 Click the  (Start) icon on the [Batch] assistant bar. This starts continuous data 

acquisition according to the Batch Table. 
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4.3.2 Pausing Continuous Data Acquisition
Continuous data acquisition can be paused so that rows of the Batch Table that have not undergone data 
acquisition can be edited. This section describes how to delete a row of the Batch Table that has not 
undergone data acquisition.

1 During continuous data acquisition, click the  (Pause/Restart) icon on the [Batch] 

assistant bar. 

Data acquisition of the currently executing row is continued as it is. 

2 Select the row on the Batch Table to be deleted, right-click the selected row, and click 

[Delete Row]. 

The selected row is deleted.

3 Click the  (Save) icon on the toolbar. 

The batch file is overwritten and saved.

4 To resume continuous data acquisition, click the  (Pause/Restart) icon again on the 

[Batch] assistant bar. 

Data acquisition is resumed. 

To cancel data acquisition without resuming it, click the  (Stop) icon. 

4.3.3 Stopping Continuous Data Acquisition

1 Click the  (Stop) icon on the [Batch] assistant bar. 

Continuous data acquisition is stopped. 
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4.3.4 Partially Executing Continuous Data Acquisition

1 Select the row No. of the Batch Table to perform partial execution.

2 Click the  (Start) icon on the [Batch] assistant bar. 

The [Select Batch Execution Range] sub-window opens.

3 Check [Start], and click [Selected Row(s)]. 

Batch processing of the selected rows is partially executed.

Partial execution is not available when TurboMatrixHS is connected.

4.4 Using Batch Queue to Perform Additional Data 
Acquisition

This software enables data to be acquired consecutively using different batch files. Batch files used for 
continuous data acquisition are registered to a memory area called "batch queue."

4.4.1 Creating Additional Batch Files

1 Start up the [GCMS Analysis Editor] program, and click the  (Batch Processing) 

icon on the [Real Time] assistant bar. 

The [Batch Table] window opens.
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2 Create the batch file to add to the batch queue, and save the file under a new name.

 

3 Exit the [GCMS Analysis Editor] program. 

• Data acquisition is not started if there are duplicate data file names or a non-existent method file 
has been specified. 

• The batch queue function operates only when the [GCMS Analysis Editor] program has been 
exited. 

4.4.2 Adding Batch Files

1 Start up the [GCMS Real Time Analysis] program. 

During data acquisition, two windows, the [Acquisition] and [Batch Table] windows are displayed 
simultaneously.
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2 Click the [Batch Table] window.

The content of the toolbar, menu bar and assistant bar is changed. 

3 Select [Batch Queue] on the [Batch] menu. 

The [Batch Queue] sub-window opens. 

4 Click [Add], and select the batch file to add. 

The [Batch Queue] sub-window displays a list of registered batch files, and data acquisition is 
continuously performed on the files in order from the top of the queue. 
The order of registered batch files can be changed by the [Move Up] / [Move Down] buttons, and 
registered batch files can be deleted from the list by the [Remove] button. 

5 After editing the batch file list, click [OK]. 

The batch file is added to the batch queue.
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4.5 Displaying Remaining Time of Continuous Data 
Acquisition

The remaining time of the current continuous data acquisition can be displayed after the acquisition is 
started. When batch files are set to the batch queue, the remaining time for completing all batch files is 
displayed.

1 Open the [Batch Table] window, and click [Option] on the [Tools] menu.

The [Setting Options] sub-window opens.

2 Open the [Batch Processing] tab page.
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3 Select [Display Remaining Time to Batch Processing End.].

4 Click [OK] to close the [Setting Options] sub-window.

5 Click the  (Start) icon on the [Batch] assistant bar.

The remaining time for completing the acquisition is displayed in the instrument monitor.

The remaining time display can be configured only when all items below meet in the System 
Configuration.

• Number of analytical lines: 1

• Autosampler: AOC-20i or AOC-20i+s

• Injection port: SPL

• Detector: MS

4.6 Entering the Ecology Mode after Continuous Data 
Acquisition

The ecology mode is a function for reducing the amount of electrical power and carrier gas consumed 
during standby for data acquisition. The instrument can be switched to the ecology mode after all 
continuous data acquisition operations end. 

1 Open the batch file to be used for continuous data acquisition. 

2 Select [Enters Ecology Mode when ending Realtime Batch] on the [Batch] menu. 

A checkmark is added to the selected menu item. 

ZStanius
Highlight

ZStanius
Typewriter
1.6.1

ZStanius
Highlight

ZStanius
Highlight
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3 Click the  (Start) icon on the [Batch] assistant bar. A message for confirming the 

ecology mode is displayed. Click [Yes]. 

The instrument switches to the ecology mode after all continuous data acquisition operations including 
batch queue end. 

Though the setting to enter the ecology mode after batch processing ends can be cancelled by 
repeating Step 2, it is recommended that this setting remain enabled at all times. 

In the ecology mode, the [Ecology Mode] sub-window is displayed. To perform operations in other 
sub-windows in the [GCMS Real Time Analysis] program, cancel the ecology mode. 

To cancel the ecology mode, click the [Cancel] button in the [Ecology Mode] sub-window. 

After the ecology mode is canceled, the instrument returns to the mode before it switched to the 
ecology mode. 

4.7 Errors During Batch Analysis
This section describes main instrument-related errors that occur during batch analysis, and whether batch 
analysis is continued or canceled according to each error. 

Error Code Error Message Real Time Batch

0x0D47 The specified vial does not exist. Batch analysis is continued.

0x0D55 The specified vial does not exist. Same as above

0x0D95 Over 25,000 hours of usage. Be 
sure to perform maintenance on 
turbo molecular pump.

Same as above

0x0D9F Filament in ion gauge consumed. Same as above

0x0DA2 Vacuum level deterioration. Filament 
turned off.

Same as above

0x0DA3 Filament turned on again. Same as above

0x0DAD Filament 1 consumed. Same as above
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0x0DAE Filament 2 consumed. Same as above

0x0DB6 Ion gauge cannot be controlled 
normally.

Same as above

0x0DA7 Vacuum level deterioration. Same as above

0x0D98 Filament 1 consumed. Filament 
switched.

Batch analysis is canceled.

0x0D99 Filament 2 consumed. Filament 
switched.

Same as above

0x0DA0 Detector saturated. Same as above(*1)

0x0D9C Trap/Total current is insufficient. Same as above

0x0D9D R.F. power source error. Same as above

0x0D9E Detector high-voltage power supply 
error.

Same as above

0x0DB1 Total current is insufficient. Same as above

0x0DB0 Trap current is insufficient. Same as above

0x0DB2 Conversion dynode power source 
error.

Same as above

---- (AOC-20i/s-related error)(*2) Same as above

0x0D80 - 
0x0D91

(Instrument communications-related 
error)(*3)

Same as above

0x0D92 Vacuum system is not ready. Same as above

0x0F00 Connection to instrument failed. Same as above

0x0F01 Process stopped due to active 
instruments.

Same as above

0x0F02 Received error status. Same as above

0x0F03 Received unexpected status. Same as above

0x0F04 Failed to initialize instruments. Same as above

0x0F06 Communication Hardware is not 
connected.

Same as above

0x4300 CID gas flow rate may be insufficient 
or unstable. 

Same as above

0x4301 CID gas flow rate may be insufficient 
or unstable. 

Same as above

0x4302 CID gas flow rate may be insufficient 
or unstable. 

Same as above

0x4303 The connection with the GC unit 
failed.

Same as above

0x4304 Detected carrier gas leak. Cooling 
down column oven, and then turning 
off flow controller.

Same as above

0x4305 Detected carrier gas leak. Cooling 
down column oven, and then turning 
off flow controller.

Same as above

0x4306 Vacuum level doen't come to be 
enough. Vacuum system will shut 
down automatically.

Same as above

0x4307 An abnormality occurred in the 
vacuum system. The vacuum 
system will stop automatically.

Same as above

0x4308 Turbo molecular pump 1 isn't ready. Same as above

0x4309 Ion gauge can not be controlled 
normally.

Same as above

0x430A Filament in ion gauge consumed. Same as above

Error Code Error Message Real Time Batch
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0x430B Ion gauge can not be controlled 
normally.

Same as above

0x430C Ion source temperature can not be 
controlled normally.

Same as above

0x430D Ion source temperature sensor error. Same as above

0x430E Ion source temperature can not be 
controlled normally.

Same as above

0x430F Ion source temperature can not be 
controlled normally.

Same as above

0x4310 Conversion dynode power source 
error.

Same as above

0x4311 Detector high-voltage power supply 
error.

Same as above

0x4312 Detector saturated. Same as above

0x4313 An error occurred in the high-
frequency power supply (Q1 Main 
rod).

Same as above

0x4314 An error occurred in the high-
frequency power supply (Collision 
Cell).

Same as above

0x4315 An error occurred in the high-
frequency power supply (Q3 Main 
rod)

Same as above

0x4316 The temperature may be unstable 
(Q1 RF capacitor).

Same as above

0x4317 The temperature may be unstable 
(Q3 RF capacitor).

Same as above

0x4318 The temperature may be unstable 
(Q1 RF capacitor).

Same as above

0x4319 The temperature sensor is 
disconnected (Q1 Main rod).

Same as above

0x431A The temperature may be unstable 
(Q3 RF capacitor).

Same as above

0x431B The temperature sensor is 
disconnected (Q3 Main rod).

Same as above

0x431C Temperature of DI probe can not be 
controlled normally.

Same as above

0x431D DI probe is not set or something 
wrong.

Same as above

0x431E Temperature of DI probe can not be 
controlled normally.

Same as above

0x431F Temperature of DI probe can not be 
controlled normally.

Same as above

0x4320 Trap/Total current is insufficient. Same as above

0x4321 Filament 1 consumed. Filament 
switched.

Same as above

0x4322 Filament 1 consumed. Data 
acquisition stopped.

Same as above

0x4323 Filament 2 consumed. Filament 
switched.

Same as above

0x4324 Filament 2 consumed. Data 
acquisition stopped.

Same as above

0x4325 Ion gauge can not be controlled 
normally. Data acquisition will stop.

Same as above

Error Code Error Message Real Time Batch



4  Continuous Data Acquisition

70   GCMSsolution Instruction Manual

(*1)When the [The batch analysis does not stop even when the signal to the detector is saturated.] 

checkbox is selected on the [Batch Processing] tab of the [Setting Options] dialog box, this error is not 

counted as an error.

(*2) Refer to Troubleshooting section in GC-2030 Instruction Manual (PDF file) for details.

(*3) Refer to Error Message Help for details.

There are other errors in addition to the above that cancel batch analysis or allow it to continue. Refer to 
GCMS Help for more information.

0x4326 Ion gauge can not be controlled 
normally. Data acquisition will stop.

Same as above

0x4327 Q1 RF Heater has stopped. Batch analysis is continued.

0x4328 Q3 RF Heater has stopped. Same as above

0x4329 Q1 RF Fan has stopped. Same as above

0x432A Q3 RF Fan has stopped. Same as above

0x432B Main Fan has stopped. Same as above

0x432D Detected carrier gas leak. Stop ion 
source heater.

Batch analysis is canceled.

0x433D Filament 1 consumed. Same as above

0x433E Filament 2 consumed. Same as above

0x433F Vacuum level. Deterioration. Heater 
in MS turned off.

Same as above

0x4340 Vacuum level. Deterioration. Heater 
in MS turned off.

Same as above

0x4341 Vacuum level. Deterioration. High 
voltage and filament are immediately 
switched off.

Same as above

0x4342 Vacuum level. Deterioration. High 
voltage and filament are immediately 
switched off.

Same as above

0x4343 Vacuum level. Deterioration. Ion 
gauge is immediately switched off.

Same as above

0x4347 Vacuum level. Deterioration. High 
voltage and filament are immediately 
switched off.

Same as above

Error Code Error Message Real Time Batch
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5Postrun Analysis

This chapter describes how to display the results of acquired data and how to set data processing 
parameters during postrun analysis. In the [Data Analysis] window, one data file is analyzed. 

^ Reference
Multiple data files are analyzed in the [Quant Browser] window. For details, see "6 Quant Browser". 

5.1 [Data Analysis] Window

The [Data Analysis] window has the following views. 

• [Chromatogram View] which comprises a full chromatogram that displays the entire chromatogram after data 
acquisition, and a zoomed chromatogram that displays an enlarged chromatogram 

• [Spectrum View] for displaying the spectrum of the retention time (or retention time range) specified in 
[Chromatogram View] 

• [Quantitative View] for displaying the quantitative chromatogram of the compound selected in [Compound 
Table View], the calibration curves, and reference ion information 

• [Compound Table View] for displaying the settings or identification results of the Compound Table in the data 
file.

5.1.1 Opening the [Data Analysis] Window

1 Start up the [GCMS Postrun Analysis] program.

2 Click the  (Qualitative) icon or  (Quantitative) icon on the [Postrun] assistant 

bar. 

The [Data Analysis] window opens.

1 2 43



5  Postrun Analysis

72   GCMSsolution Instruction Manual

5.2 Displaying Chromatograms and Spectra

This section describes how to display chromatograms and spectra in the [Data Analysis] window. 

1 Click the  (Qualitative) icon on the [Postrun] assistant bar. 

No. Name Explanation

1 Chromatogram View The upper level displays the TIC or MIC of all measurement 
times after data acquisition. The lower level displays the 
enlarged TIC, MIC and MC. The sample information is 
displayed on the right side. 

2 Spectrum View Displays the spectrum of the retention time (or retention time 
range) specified in [Chromatogram View]. When data is 
acquired with multiple events, spectra for all events registered 
to the group to which a specified retention time belongs are 
displayed in a stack. 

3 Quantitative View Displays the quantitative chromatogram of the compound 
selected in [Compound Table View], the calibration curves, and 
reference ion information. 

4 Compound Table View Displays the settings or identification results of the Compound 
Table in the data file, and the settings or grouping results of the 
Grouping Table. 
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2 Drag-and-drop the data file from the [Data] tab page in the [Data Explorer] sub-window 

onto the [Data Analysis] window. 

The content of the data files is displayed in the [Data Analysis] window.
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5.2.1 Chromatogram View
[Chromatogram View] displays chromatograms and the instrument status curves.

No. Name Explanation

1 Chromatogram information Displays the range indicating TIC and MIC. Displays the range 
of the group number of the zoomed chromatogram. 

2 Chromatogram label Displays the event No., m/z and magnification of the currently 
displayed chromatogram. 

When a reference data file is open, the reference data file 
No. and m/z of the chromatogram are also displayed. 

3 Graph comment Displays the retention time, scan number and intensity of the 
mouse position, the column oven temperature when sample is 
injected from the GC, and the DI temperature when sample is 
injected from the DI. 

4 Peak Moves the vertical line to the peak top of the adjacent peak, 
and displays the spectrum of that retention time in [Spectrum 
View] when the peaks of the chromatogram are detected. 

5 Scan Displays the spectrum of the retention time of the immediately 
preceding or following scan in [Spectrum View]. 

6 Group Displays the chromatogram of the immediately preceding or 
following group in the zoomed chromatogram. 

7 Full chromatogram Displays the TIC or MIC of all measurement times after data 
acquisition. 
Dragging the pointer across the chromatogram displays an 
enlarged view of the range indicated by dragging. 

When a reference data file is open, the chromatogram of 
the reference data file is also displayed. 

8 Zoomed chromatogram Displays the chromatogram according to the Fragment Table. 
Dragging the pointer across the chromatogram displays an 
enlarged view of the range indicated by dragging. 

When a reference data file is open, the chromatogram of 
the reference data file is also displayed. 

1 4 5 6

9

3

7

8

2

0a
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Set the view ratio between the full chromatogram and zoomed chromatogram, and full chromatogram and 
sample information display/hide selection in the [Chromatogram View Display Setting] sub-window. 

To open the [Chromatogram View Display Setting] sub-window, click [Display Settings] - [Chromatogram 
View] on the [View] menu. 

5.2.2 Spectrum View
[Spectrum View] displays the spectrum of the retention time (or retention time range) specified in 
[Chromatogram View]. 

In the case of data files acquired by measuring with multiple events, spectra for all events registered to the 
group to which a specified retention time belongs are displayed in a stack. 

9 Sample information Displays the sample information. "There is an error log" is 
displayed when an error is logged during data acquisition. 
When a reference data file is open, the reference data file No. 
and file name are displayed. 

0 (vertical line) Displays a vertical line at the retention time by which spectra 
are extracted. 

a Peak top comment Displays the information of the detected peak. 
Items displayed in the [Chromatogram View Properties] sub-
window can be selected. Some of the items in reference data 
files cannot be displayed as peak top comments. 

^ Reference
For details, refer to Help.

No. Name Explanation

No. Name Explanation

1 Spectrum information Displays the event No. of the spectrum, acquisition mode, 
mass according to acquisition mode, retention time, scan No., 
and retention index. 

Mass according to acquisition mode refers to the mass of 
the precursor ion when the spectrum in the product ion 
scan mode is displayed, the mass of the product ion in the 
precursor ion scan mode, and the "Losses of" mass in the 
neutral loss scan mode.

1 3

56

2 4
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Whether or not a spectrum is displayed for each event when measurement has been performed by 
multiple events can be set in the [Spectrum Graph Display Setting] sub-window. Also, the number of 
spectra displayed in a single sub-window and display/hide of the standard spectrum of the 
Compound Table are set in this sub-window. 

By default, [The number of display spectrum] is set to "1". When analyzing data scanned using 
multiple events (data acquired by Product Ion Scan, Precursor Ion Scan, or Neutral Loss Scan), set 
a high value, "10" for example, to display all events in the [Spectrum View].

To open the [Spectrum Graph Display Setting] sub-window, click [Display Setting] - [Spectrum View] 
on the [View] menu.

^ Reference
For details on how to display the standard spectrum, see "5.2.6 Displaying the Standard Spectrum in 
[Spectrum View]". 

2 Graph comment Displays the mass, peak intensity and relative intensity at the 
mouse position.

3 Base peak Displays m/z and intensity values for base peaks.

4 Regist This is displayed on the upper right of a spectrum for each 
event. The currently displayed spectra for the corresponding 
events are registered to the spectrum process table.

5 Spectrum Displays the spectrum of the retention time at the vertical line of 
[Chromatogram View] according to the spectrum format 
parameters.

In the case of events in the MRM and product ion scan 
acquisition modes, the horizontal axis of the displayed 
spectrum becomes the scale of the Q3. 

In the case of events in the precursor ion scan and neutral 
loss scan acquisition modes, the horizontal axis of the 
displayed spectrum becomes the scale of the Q1. 

6 Active mark This is displayed on the left side of the active spectrum. A 
similarity search can be performed on the spectrum, the library 
can be registered to the spectrum, and the MS Table can be 
displayed. 

No. Name Explanation
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5.2.3 Quantitative View
[Quantitative View] displays the quantitative chromatogram, calibration curves, and reference ion 
information of the compound selected in [Compound Table View]. 

Set the quantitative chromatogram and calibration curve, and display/hide selection of the 
reference ion information in the [Quantitation View Display Setting] sub-window.

To open the [Quantitation View Display Setting] sub-window, click [Display Settings] - 
[Quantitation View] on the [View] menu. 

No. Name Explanation

1 Quantitative chromatogram Displays the target ion of the compound selected in [Compound 
Table View], and the chromatogram of the reference ion. 

When a reference data file is open, its quantitative 
chromatogram is displayed in a stack under the 
measurement data file.

2 Chromatogram label Displays the m/z of the currently displayed quantitative 
chromatogram according to the ID chromatogram Fragment 
Table. 

3 Peak top comment Displays the information of the detected peak. 
Items to be displayed can be selected in the [Chromatogram 
View Properties] sub-window. 

4 Calibration curve Displays the calibration curve of the compound selected in 
[Compound Table View]. 

When a reference data file is open, sample information is 
displayed in a stack under the measurement data file 
instead of the calibration curve.

5 Reference ion information Displays the m/z, area/height/mass, setting% and 
measurement% of the intensity ratio, and allowable width of the 
target ion and reference ion.

This information can be edited by clicking  in [Compound 
Table View]. 

1

5

42 3
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5.2.4 Displaying the Spectrum of a Specific Retention Time

1 In [Chromatogram View], place the mouse pointer over the retention time to be extracted 

as the spectrum, and double-click it. 

The spectrum at that retention time position is displayed in [Spectrum View].

5.2.5 Displaying the Chromatogram of a Specific m/z

1 Double-click the m/z of the chromatogram to display in [Spectrum View]. 

That m/z is registered to the Fragment Table, and the chromatogram is displayed in the zoomed 
chromatogram. 
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5.2.6 Displaying the Standard Spectrum in [Spectrum View]
The standard spectrum currently registered to the Compound Table can be displayed at the lowermost 
level of [Spectrum View]. 

1 Click [Spectrum View] - [Display Setting] on the [View] menu.

The [Spectrum Graph Display Setting] sub-window opens.

2 Select [Display Standard Spectrum], and click [OK]. 

The standard spectrum is displayed under the measured spectrum. 
The range of the mass axis is aligned with the measurement spectrum of event 1 and the standard 
spectrum, whichever is larger. 

3 Drag on the spectrum to enlarge it. 

Both the measured spectrum and standard spectrum are displayed zoomed. 

To initialize zoom, right-click the spectrum, and select [Initialize Zoom] on the displayed menu. Both 
the measured spectrum and standard spectrum are initialized. 
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5.2.7 Comparing the Quantitative Chromatogram with Other 
Measurement Data
The chromatograms of up to three reference data files can be displayed in [Chromatogram View] and 
[Quantitative View], and the chromatograms of multiple data, such as standard spiked samples, can be 
compared on the same sub-window. 

Opening Reference Data Files

1 Click [Open Reference Data File] on the [File] menu.

2 In the [Open Data File] sub-window, select the reference data file, and click [Open].

The chromatogram is displayed in [Chromatogram View] and [Quantitative View]. 

• GCMS data files and data files measured with GC-2010 detectors can be selected. Data files 
measured with GC-2030 detectors cannot be selected.

• Analysis processing cannot be performed on the chromatograms of reference data files.

Closing Reference Data Files

1 On the [Close Reference Data File] sub-menu of the [File] menu, click the file to close. 

Even if the reference data file is closed, the data file open in the [Data Analysis] window does not 
close. 

5.2.8 Comparing Chromatograms with the Intensity Axis of the 
Quantitative Chromatogram Fixed

When the reference data file is open, the quantitative chromatograms of the measurement data file and 
reference data file are displayed in a stack in [Quantitative View]. 
The intensity axis of quantitative chromatograms displayed in [Quantitative View] can be fixed to the 
identified peaks in a specified data file. By fixing the intensity axis, whether or not the chromatogram 
contains the target component and whether or not the peak of the component is at the detection limit or 
below can be checked at a glance.

1 In [Quantitative View], right-click the chromatogram to fix the intensity axis, and click 

[Fix the Intensity Axis to this Data.]. 

Select the data file used as the detection limit such as data file for a calibration curve level 1. 
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2 Check presence of the target component. 

1 In [Compound Table View], click the row of compound. 

2 In [Quantitative View], check whether or not the peak is at the detection limit or below. 

In the figure below, it can be seen that the peak is at the detection limit or above since the 
chromatogram is displayed exceeding the maximum value of the intensity axis of the graph. 
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5.3 Qualitative Processing
This section describes how to set peak integration parameters, perform qualitative peak integration on 
chromatograms to detect peaks, search spectra from the library, and identify components. 

Qualitative processing (e.g. peak detection or registration of spectra to the Spectrum Process Table) 
can only be performed on event 1. 

5.3.1 Flow of Qualitative Processing
1. Peak detection
Detect peaks to extract the spectrum for searching from the library. Peaks are detected manually and 
automatically.

^ Reference
See "5.3.2 Performing Qualitative Peak Integration Automatically" and "5.3.4 Performing Qualitative 
Peak Integration Manually". 

2. Spectrum search from library
Compare spectra registered to the library file with the spectra of detected peaks to display library spectra 
as a list in order of highest similarity. Components are identified by comparing the spectra of detected 
peaks with the list.

^ Reference
See "5.3.6 Searching Spectra from the Library".

5.3.2 Performing Qualitative Peak Integration Automatically
This section describes how to set peak integration parameters to automatically detect peaks.

1 Click [Peak Integrate] on the [Qualitative] menu, and select the m/z to perform peak 

integration with on the sub-menu. 
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2 In the [Qualitative Parameters] sub-window, set the peak integration parameters, and 

click [OK].

The chromatogram of the specified m/z undergoes peak integration and the peak is detected. The 
baseline, peak detection mark, and peak top comment are displayed on the detected peak. 
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Integration Time Program

If the peak integration parameters must be changed according to the retention time to detect peaks, set 
an integration time program. 

1 Click  at the peak integration parameters.

2 Create an integration time program, and click [OK].

1 At [Time], enter the retention time at which to execute the command. 

At [Command], select the processing content. 

Set values for processing at [Value], if required. 

^ Reference
For details about each of the parameters, refer to Help.

• The [Load Chrom] sub-window opens by clicking the [Load Chrom] button. When a data file is 
selected and [Open] is clicked, TIC is displayed at the top of the sub-window. When a 
chromatogram is clicked with the [Time] cell selected, the retention time for the clicked part of 
the chromatogram is set to the cell. 

• Clicking the [Simulate] button executes a simulation of peak integration on the chromatogram 
using the content set in the peak integration program. 

1
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5.3.3 Checking the Peak Integration Results
Detected peaks can be checked in the Peak Table. The Peak Table is divided into tabs for each m/z. 

1 Click the  (Qualitative Table) icon on the [Qualitative] assistant bar. 

2 Select the tab of the desired m/z to check the result. 

A compound name can be displayed as a peak top comment on the chromatogram by entering the name 
in the [Name] cell. 

5.3.4 Performing Qualitative Peak Integration Manually
This section describes how to perform peak integration manually when peaks cannot be detected even by 
changing the peak integration parameters. 

Detection of Peaks

1 In the zoomed chromatogram, click the chromatogram label of the m/z whose peak is to 

be detected. 

The corresponding chromatogram is displayed by a bold line for a preset duration. 
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2 Move the mouse cursor over the chromatogram, and drag from the start point to the end 

point using the right mouse button with the [Shift] key held down.

During the drag operation, the mouse pointer changes to a vertical line. 
The base line is drawn joining the start and end points, and the peaks are detected.

• This operation can be also executed by clicking [Manual Peak Integrate] on the [Qualitative] 
menu, and selecting the m/z to perform peak integration with on the sub-menu. 

• By dragging from the start point to the end point using the right mouse button with the [Ctrl] key 
held down, peaks are detected with the baseline kept horizontal. 

Deletion of Peaks

1 In the zoomed chromatogram, click the chromatogram label of the m/z whose peak is to 

be deleted. 

The corresponding chromatogram is displayed by a bold line for a preset duration. 
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2 Double-click between the peak start time to end time with the [Shift] key held down. 

The peak is deleted.

Movement of Detection Point

1 In the zoomed chromatogram, move the mouse pointer to near the peak detection point 

(start point or end point). 

The mouse pointer changes to a triangle.
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2 Click the detection point and drag-and-drop onto the time where the detection point is to 

be moved.

During the drag operation, the mouse pointer changes to a vertical line, and the baseline correction line 
(red) moves. 

The detection point moves to the dropped retention time, and peak integration is performed. 

The baseline can be easily changed when the peaks are tailing or leading. 

Do not move the detection point beyond the adjacent peak. 

Splitting of Peaks

1 In the zoomed chromatogram, click the chromatogram label of the m/z whose peak is to 

be split. 

The corresponding chromatogram is displayed by a bold line for a preset duration. 
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2 Click [Split Peak] on the [Qualitative] menu. 

The mouse pointer changes to a cross. 

3 Click at the retention time where the peak is to be split.

The peak is split at that retention time and is detected as respective peaks. 

4 Click [Split Peak] on the [Qualitative] menu again to end peak splitting.

5.3.5 Performing Average/Subtraction Processing on Spectra
When a peak is selected and its spectrum is displayed in [Chromatogram View], average/subtraction 
processing is performed on the spectrum according to the spectrum processing parameters, and the 
resulting spectrum is displayed. 

The same operation can be also performed when making a Spectrum Process Table from a Peak Table or 
when displaying the spectrum of a compound selected in [Compound Table View]. 

This section describes how to manually perform average/subtraction processing on a spectrum to obtain a 
clearer spectrum. 

A processed spectrum can be easily reproduced later if it is registered to the Spectrum Process Table 
beforehand. 

Averaging of Spectra

1 Click  (Average Spectrum) on the toolbar. 
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2 In [Chromatogram View], drag from the start to end time to be averaged.

During the drag operation, the mouse pointer changes to a vertical line. 

The average spectrum within the dragged time range is displayed in [Spectrum View]. 

Averaging near the top of peaks on the chromatogram is more effective. 

Subtraction of Spectra

1 Click  (Subtract Spectrum) on the toolbar. 

2 In [Chromatogram View], double-click at the time to perform subtraction. 

The spectrum obtained by subtracting the spectrum at the specified time in background is displayed in 
[Spectrum View]. 
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In the case of the following peaks, set the part marked by arrows as the background processing 
position. 

Averaging and Subtraction of Spectra

1 Click  (Average Subtract Spectrum) on the toolbar. 

2 In [Chromatogram View], drag the time range to perform subtraction on. 

The spectrum obtained by subtracting the spectrum in the dragged time range in background is displayed 
in [Spectrum View]. 

• Subtracting near the start or end of the peaks on the chromatogram is more effective. 

• To further perform subtraction on already subtracted peaks, either click  (Subtract Spectrum) 
or double-click at the time to perform subtraction with the [Shift] key held down, or click 

(Average_Subtract Spectrum) and drag the time range to perform subtraction in with the 
[Shift] key held down. 

Example 1) Example 2) Example 3)

Either OK
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Display of Spectrum Calculation Results

The top of [Spectrum View] displays which time range was calculated. 

Registering Spectra in [Spectrum View] to the Spectrum Process Table

1 Display the spectrum for the event to register, and click the  icon.

The spectrum of [Spectrum View] is added to the end of the Spectrum Process Table. 

Display Text String Explanation

[10.000] Displays a spectrum with retention time 10.000 min. 

[10.000 -> 10.100] Averages from retention time 10.000 min through 10.100 min. 

[10.000] - [10.500] Subtracts the spectrum at 10.500 min from the spectrum with retention time 
10.000 min.

[10.000 -> 10.100] - 
[10.500]

Averages from retention time 10.000 min through 10.100 min, and subtracts the 
spectrum at 10.500 min from that range. 

[10.000 -> 10.100] -
[10.500 -> 11.000]

Averages from retention time 10.000 min through 10.100 min, averages from 
retention time 10.500 min through 11.000 min from that, and subtracts the result 
of averaging as background. 

[10.000 -> 10.100] - 
[10.500] - [10.040]

Averages from retention time 10.000 min through 10.100 min, subtracts the 
spectrum at 10.500 min from that range, and further subtracts the spectrum at 
10.040 min. 
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Checking the Spectrum Process Table

1 Click the  (Qualitative Table) icon on the [Qualitative] assistant bar. 

2 Select the [Spectrum Process] tab. 
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5.3.6 Searching Spectra from the Library
You can compare the spectra of peaks detected in a chromatogram with the spectra in library files that 
have a high similarity to identify components, or filter library spectra using a specific search index as the 
search key.
This section describes how to perform a similarity search for spectra in [Spectrum View] and in the 
Spectrum Process Table.

Setting Similarity Search Parameters

1 Click [Qualitative Parameters] on the [Qualitative] menu. 

2 On the [Similarity Search] tab page, set the search parameters, and click [OK]. 

1 Up to five library files can be set. The minimum similarity of the library spectrum to search can be set 
to each library file. 

^ Reference
For details about each of the parameters, refer to Help.

When a library file name is not set in the similarity search parameters, the similarity search is 
performed using the default library. The default library is set in the sub-window that opens by 
clicking [Set Default Library] on the [Tools] menu in the [Data Analysis] window. 

1
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Performing a Similarity Search on the Spectra in [Spectrum View]

1 Click the  (Similarity Search) icon on the [Qualitative] assistant bar. 

The [Similarity Search Results] sub-window is displayed.

Right double-clicking on mass spectra also executes a similarity search.

No. Name Explanation

1 Search results list Displays the results of the similarity search in order of highest 
similarity. 

2 Similarity Displays how similarity among spectra with 100 used as the 
match reference. 

3 Register Select the target compound checkbox when registering a 
compound name to the Spectrum Process Table. 

7

8

9

651 2 3 4

0
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To print the results of the similarity search, click [Search Results] on the [Report] menu in the [Similarity 
Search Results] sub-window. 

Performing a Similarity Search on Spectra in the Spectrum Process Table

1 Click the  (Qualitative Table) icon on the [Qualitative] assistant bar. 

The [Qualitative Table] sub-window is displayed. 

4 Copy marked compound name to 
the Spectrum Process Table

Copies compound names whose [Register] checkbox is 
selected to the Spectrum Process Table. 

This button is displayed only when a search has been 
made from the Spectrum Process Table. 

5 (Spectrum Processing Table # spin 
buttons)

Switches the row numbers of the Spectrum Process Table. The 
target spectrum switches to the spectrum of the row after 
switching, and the hit list and search results are also switched 
according to the content of that spectrum. 

This button is displayed only when a search has been 
made from the Spectrum Process Table. 

6 Register Target Spectrum to 
Spectrum Process Table

Adds the target spectrum to the end of the Spectrum Process 
Table. 

This button is displayed only when a search has been 
made from [Spectrum View]. 

7 Target spectrum Displays the target spectrum.

8 Library spectrum Displays the spectrum of the compound selected at the search 
results list. 

9 Comparison/Information/Subtraction The display content is switched by clicking [Compare]/
[Information] / [Subtracted] on the [View] menu. 
[Compare] displays the library spectrum.
[Information] displays the compound information for the library 
spectrum. 
[Subtracted] displays the spectrum obtained by subtracting the 
library spectrum from the target spectrum. 

0 (Library spectrum spin buttons) These are used to switch the library spectrum.

No. Name Explanation
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2 On the [Spectrum Process] tab page, click [Search All Table] on the [Similarity Search] 

menu. 

The similarity search is executed, and "Done" is displayed at the [Search] row. 

• Correct search results are not displayed when a similarity search is performed on spectra 
obtained by MS/MS measurement. 

• If the [Copy Compound Name of Hit #1 to Spectrum Process Table] is selected, the compound 
name of the compound having the highest similarity is copied to the [Name] cell after the similarity 
search is performed. 

3 Double-click the similarity-searched row. 

The [Similarity Search Results] sub-window is displayed. 

When a similarity search is performed from the Spectrum Process Table, the search results are also 
saved when the data file is saved. 

5.3.7 Printing Graph Images
This section describes how to print chromatograms and spectra that have been analyzed in the [Data 
Analysis] window. 

1 Display or analyze chromatograms or spectra in the [Data Analysis] window. 

2 Select [Print Image] on the [File] menu, and click [Preview]. 

The [Report] window opens.
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3 Check the chromatogram and spectra in the preview sub-window, and click [Print].

• To edit a report format, select [Print Image] on the [File] menu, and click [Edit Format]. The 
[Report] window opens, and the format can be edited. If an edited format is saved, it can be used 
when next printing graph images. 

• To return an edited format to the default format, select [Print Image] on the [File] menu, and select 
[Initialize Format]. This returns the format to its default state when GCMSsolution was installed. 
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5.4 Quantitative Processing

This section describes how to set quantitative parameters to perform quantitative processing. 

5.4.1 Flow of Quantitative Processing
1. Creation of Compound Tables
Create the Compound Table required for setting peak integration parameters, making calibration curves 
and performing quantitative processing. 
There are several ways of creating a Compound Table. 

^ Reference
See the following sections:

• In case of data obtained by measurement by event 1 in Q3 Scan acquisition mode, etc., see 
"5.4.2.1 Creating Compound Tables Using the Wizard".

• In case of data acquired in MRM or SIM acquisition mode, see "5.4.2.2 Creating Compound 
Tables from MS Tables in the Method".

• See "5.4.2.3 Copying from Spreadsheet Format Files to Create Compound Tables".

2. Creation of calibration curves
Make calibration curves based on the Compound Table created at 1. 

^ Reference
See "5.4.3 Creating Calibration Curves".

3. Data acquisition of unknown samples
Acquire data of unknown samples whose concentrations are to be calculated.

^ Reference
See "3 Data Acquisition".

4. Execution of quantitative calculation
Perform quantitative peak integration on the data file of the unknown samples to identify compounds and 
calculate their concentrations. 

^ Reference
See "5.4.4 Performing Quantitative Processing on Unknown Samples", "5.4.6 Performing 
Quantitative Peak Integration Manually" and "5.4.7 Performing Identification Manually".

5. Confirmation of quantitative results
Check the identification results and quantitative calculation results. 

^ Reference
See "5.4.5 Checking the Quantitative Calculation Results".

5.4.2 Creating Compound Tables

5.4.2.1 Creating Compound Tables Using the Wizard
This section describes how to create Compound Tables from data measured by Event 1 in Q3 scan mode, 
etc., using the Compound Table Creation Wizard.

The event numbers for Compound Tables created with the Compound Table Creation Wizard will all be "1".
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1 Load the data file to the [Data Analysis] window.

2 Click the  (Create Compound Table) icon on the [Postrun] assistant bar. 

3 Click the  (Wizard(New)) icon on the [Compound] assistant bar. 

4 Select "1" or "2", and click [Next].

5 Check the number of spectra registered to [Spectrum Process Table], and click [Next].

No. Name Explanation

1 Use current Spectrum Process Table Creates a Compound Table using the spectra already 
registered to the Spectrum Process Table.
Before starting up the Compound Table Wizard, register the 
required spectra to the Spectrum Process Table. 

2 Integration of TIC Performs peak integration on TIC, and creates a Compound 
Table using the spectra of detected peaks.
Clicking the [Integration Param] button opens the sub-window 
for setting the qualitative peak integration parameters. Clicking 
the [Spectrum Format] button opens the sub-window for setting 
the spectrum process parameters. 

^ Reference
For a detailed description of the parameters, refer to Help.

1

2
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6 Select the [Proc] column checkboxes of the spectra to be processed, and click [Next]. 

7 Set quantitative method, calibration curve and other quantitative parameters, and click 

[Next]. 

^ Reference
For details about the parameters, refer to Help.

No. Explanation

1 Select the checkboxes for the retention times of the spectra to be used for creating the 
Compound Table. 
The peaks near the retention times registered here are targeted for calculation.

2 The spectra of the rows selected in the table at 1 can be checked.

1 2

No. Explanation

1 Sets the quantitative calculation method and type of calibration curve.

2 Sets the concentration unit or format of the concentration value. 

3 By setting [Grouping], quantitative calculation of groups can be performed in addition to 
quantitative calculation for each compound. 

1

3

2
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8 Set the concentration and measurement ion, and click [Next]. 

No. Name Explanation

1 Standard Sets the concentration of the standard sample. When the 
concentration differs according to the component, correct each 
concentration after the Wizard ends. 

2 # of Reference Ions Enter the number of reference ions to be used for peak 
identification. 

3 Decimal for mass Determines the number of digits past the decimal point for the 
target ion and reference ion. Selecting [1 Decimal] improves 
sensitivity. 

4 Internal Standard Sets the concentration of the internal standard when the 
internal standard method is selected as the quantitative 
calculation method. 

3

2

4

1
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9 Set the type, compound name, target ion, and reference ion of each component, and 

click [Next] when the information pertaining to all compounds has been entered. 

1 Switch the ID of the compound to set. 

2 Select [Target] from the [Type] list.

Select [I.S.] for the internal standard substance when the internal standard method is selected 
as the quantitative calculation method. In addition, the same number must be set to the [ISTD 
Group] cells of the internal standard substance and the compounds that use that substance for 
the calculation in the Compound Table. 

1 2

4

3
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3 Change the type and mass. 

• To change the type, click the cell of the type to change, and select one of [Target Ion], [Ref. Ion] 
and [Not used]. 

• To change the mass, click the arrow button that is displayed by clicking the cell of the mass to 
change. The mass spectrum is displayed. Drag near the spectrum peak to enlarge it. The mass 
can be set by double-clicking the spectrum peak. The mass spectrum also is switched by 
changing the compound ID. 

4 The name registered to the Spectrum Process Table is automatically entered. 

If the entry field is blank, enter the compound name.

Clicking the button on the right if the similarity search has already been executed on the 
Spectrum Process Table displays a list of names of library registered substances found in the 
search. 

10 In the confirmation sub-window, click [Finish].

The Compound Table will be created. If necessary, correct the content of the Compound Table. 

To correct the content, click  at the top right of the Compound Table to set to the edit mode. 

When editing is finished, click  to set to the display mode. 
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11 Click the  (Save Compound Table) icon on the [Compound] assistant bar. 

The method file used when this data was acquired is selected. 

12 Click [Save].

5.4.2.2 Creating Compound Tables from MS Tables in the Method 
This section describes how to create Compound Tables from data acquired in the MRM or SIM acquisition 
mode.

Complete the Compound Table by setting the retention time of the Compound Table while observing the 
chromatogram peaks, and setting the reference ion ratio while observing the spectrum.

1 Load the data file to the [Data Analysis] window.

2 Click [Update compound table m/z by MRM/SIM event] on the [Compound Table] menu.

A confirmation message is displayed.

3 Click [OK].

The Compound Table enters the edit mode. 
If the Compound Table contains the same compounds as the MS Table's MRM or SIM events, update the 
m/z value of the Compound Table with the m/z setting values of the MS Table.
If there are no identical compounds, add them as new compounds to the Compound Table.

Update the m/z value set in MS Table Ch1 as the quantitation ion, and update the m/z values set in Ch2 to 
Ch6 as the reference ions.
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4 Set [Ret. Time] in the Compound Table.

1 Click the [Ret. Time] cell. 

2 Click the peak top of the chromatogram.

The retention time of the clicked position is set to the [Ret. Time] cell.

5 Set the reference ion ratio.

1 Click icon at the right end of the [Ref. Ions] cell.

The [Reference Ion Ratio] sub-window is displayed.

2 While observing the spectrum in [Spectrum View], set the relative intensity ratio of the reference ion 
when the quantitation ion is 100.
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6 Repeat steps 4 and 5 to set the retention times and reference ion ratios of all 

compounds.

7 For all compounds, set the standard sample concentrations for each level.

^ Reference
Set the number of concentration levels using the quantitative parameters. See "Changing the 
Quantitative Parameters" in "5.4.3 Creating Calibration Curves" for the procedures for revising the 
quantitative parameters.

8 Click the  icon in the Compound Table. 

The Compound Table returns to the display mode. 

9 Click the  (Save Compound Table) icon on the [Compound] assistant bar.

Select the method file used when this data was acquired.

10 Click [Save].
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5.4.2.3 Copying from Spreadsheet Format Files to Create Compound Tables
This section describes how to copy information set to spreadsheet format files that are preset with data 
acquisition settings to a Compound Table. 

1 Load the data file to the [Data Analysis] window.

2 Click the  (Quantitative) icon on the [Postrun] assistant bar. 

The [Data Analysis] window is displayed in the quantitative processing layout. 

3 Click the  icon in [Compound Table View]. 

The Compound Table enters the edit mode. 

4 Copy items from the spreadsheet format file to the Compound Table.

1 Select and copy the content in the spreadsheet format file. 
Make sure that the columns in the compound table and in the spreadsheet format file are arranged in 
the same order.

2 Click the [Name] cell in the first row of the Compound Table, and paste the content.

Rows are automatically added and the content is pasted.

5 Set the reference ion ratio.

1 Click the [Ref. Ions] cell.
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The [Reference Ion Ratio] sub-window is displayed.

2 Set the relative intensity ratio and allowable width for the reference ion when the quantitation ion is 
100.

3 Repeat steps 1 and 2 to set the reference ion ratios and allowable widths of all compounds.

To collectively set the mass, ion ratio, and allowable width for the reference ion, copy a text string in 
the following format to the [Ref. Ions] cell in the Compound Table.

Mass of reference ion 1-Mass of reference ion 2\r\nIon ratio of reference ion 1-Ion ratio of reference 
ion 2\r\nAllowable width of reference ion 1-Allowable width of reference ion 2

Specify the settings values for reference ions 1 to 5, using a "-" as a separator. The "\r\n" is an item 
(mass, ion ratio, allowable width) delimiter.

Example:

Copying "185>85-127>80\r\n60-40\r\n10-20" to the [Ref. Ions] cell will configure the following 
reference ion settings.

"185>85-127>80\r\n60-40\r\n10-20" 
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6 For all compounds, set the standard sample concentrations for each level.

Set the number of concentration levels using the quantitative parameters. See "Changing the 
Quantitative Parameters" in "5.4.3 Creating Calibration Curves" for the procedures for revising the 
quantitative parameters.

7 Click the  icon in the Compound Table. 

The Compound Table returns to the display mode. 

8 Click the  (Save Compound Table) icon on the [Compound] assistant bar.

Select the method file used when this data was acquired.

9 Click [Save].
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5.4.3 Creating Calibration Curves
This section describes how to create a calibration curve using the method file used for creating the 
Compound Table. 

Opening the [Calibration Curve] Window

1 Start up the [GCMS Postrun Analysis] program, and click the  (Calibration Curve) 

icon on the [Postrun] assistant bar. 

The [Calibration Curve] window opens.

No. Name Explanation

1 Calibration Curve View Displays the calibration curve graph and calibration curve 
information of each component (each group in the case of 
group quantitation). It also displays a table of the level of each 
calibration point, preset concentration values and area values 
(height values).

2 Compound Table View Displays the settings or quantitation results of the Compound 
Table (Grouping Table) of the method. 

3 Chromatogram View Displays the quantitative chromatogram of the compound 
selected in [Compound Table View] for the data file selected in 
[Data File Tree]. 

4 Data File Tree Displays the data files of the standard samples that comprise 
each calibration point at each level.
Calibration points can be manually added by dragging-and-
dropping the data files of the standard samples onto the 
specified level.

1

4 3

2
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Creating Calibration Curves

1 Load a method file that is set with a Compound Table.

2 Click the [Data] tab page in the [Data Explorer] sub-window, and drag-and-drop the data 

file for the standard sample onto the data file tree. 

When there are two or more levels of calibration points, drag-and-drop each of the data file 
corresponding to each level.

3 Click the (Peak Integration for All Data) icon on the [Calibration] assistant bar. 

The calibration curve is produced and displayed. 
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4 Click the  (Save) icon on the toolbar, and save the method file.

Changing the Quantitative Parameters

If necessary, change the quantitative parameters.

1 Click the  (Quantitative Parameters) icon on the [Calibration] assistant bar.

The [Quantitative Parameters] sub-window is displayed.

2 Set the parameters on the [Peak Integration] tab page so that the intended compound 

peaks can be detected.

3 On the [Quantitative] tab page, set the calibration curve.

No. Name Explanation

1 Quantitative Method • External Standard:Quantitation is performed using a
calibration curve obtained from the absolute quantity
(concentration) and the area or height value of the target
compound in a standard sample.

• Internal Standard:An internal standard is added to the
sample, the sample is analyzed, and quantitation is
performed using the relationship between the relative
sensitivity and the quantitative ratio with respect to the
internal standard compound.

2 # of Calib. Levels Input the number of concentration levels of the calibration 
curve.

1

2

3

4

5
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4 After the settings are changed, click [OK].

The calibration curve will be revised in accordance with the new parameter settings.

Printing Calibration Curves

The procedure for printing calibration curves that are produced is as follows.

1 Select [Print Image] on the [File] menu, and click [Preview]. 

The [Report] window opens.

3 Curve Fit Type Specifies how to plot the calibration curve.
• Linear: Determines the calibration curve as a straight line

from the obtained values.
• Point to point: Points are connected by a broken line. No

formula is displayed for point to point calibration curves.
• Quadratic: Curve is fit to each point using a quadratic

equation. This requires at least three points on the
calibration curve. For two points or less, the curve is
calculated as linear.

• Mean RF: First, it determines straight lines passing
through the origin and each point. Then it finds the simple
average of the slopes for each line.
Consequently, the resulting calibration curve always
passes through the origin.

4 Zero Select either [Not Forced] or [Force Through]. Normally, select 
[Not Forced].

5 Weighted Regression A typical least squares method of plotting calibration curves 
could result in a quantitation error that is larger the lower the 
concentration at the calibration point. In general, when the 
calibration curve has a large dynamic range (maximum 
concentration is at least 50 times higher than the minimum 
quantitation limit), formulas are weighted to reduce the weight 
of higher concentration points of the calibration curve. Typically, 
formulas are optimized by checking the correlation coefficient 
and contribution ratio.

• [1/C2]: Formulas are weighted by the inverse of the
concentration value squared.

• [1/C]: Formulas are weighted by the inverse of the
concentration value.

• [1/A2]: Formulas are weighted by the inverse of the area
value squared (or height value when a height is specified
for the data used).

• [1/A]: Formulas are weighted by the inverse of the area

No. Name Explanation
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2 Check the calibration curve in the preview sub-window, and click [Print].

5.4.4 Performing Quantitative Processing on Unknown Samples
This section describes how to perform quantitative calculation on unknown samples using the method file 
used for creating the calibration curve. 

1 In the [Data Analysis] window, open the data file to undergo quantitative processing. 

2 Click the  (Quantitative) icon on the [Postrun] assistant bar. 

3 Click the  (Load Method) icon on the [Quantitative] assistant bar. 

The [Load Method] sub-window opens. 

4 Select the method file that has already been used to create a calibration curve, and click 

[Open]. 
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The calibration curve and the Compound Table are loaded to the data file.

5 Click the  (Peak Integration) icon on the [Quantitative] assistant bar. 

Peak integration, identification processing and quantitative calculation are executed.

5.4.5 Checking the Quantitative Calculation Results
Check the quantitative calculation results on the [Results] tab page in [Compound Table View]. 

1 Click the [Results] tab in [Compound Table View]. 

The Identified Results Table is displayed. 

The following text strings are displayed according to cause for compounds that failed to be identified.

Display Text String Explanation

No peak is detected. The peak has not been detected by quantitative peak integration.

No Peak is found in 
Window/Band range.

The peak has not been detected within the retention time width of the 
identification parameters. 

Ratio of reference ion does 
not match.

The difference between the setting value of the reference ion ratio and measured 
value exceeds the allowable width, preventing the peak from being identified.

Under the minimum 
similarity index.

The peak has not been identified due to the calculated similarity value being the 
setting value or less when mass pattern matching is set in the identification 
parameters.
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When a row on the Compound Table is selected, the quantitative chromatogram of its compound, or 
calibration curve and reference ion information are displayed in [Quantitation View]. 

5.4.6 Performing Quantitative Peak Integration Manually
This section describes how to perform peak integration manually when peaks cannot be identified or 
detected even by setting the peak integration parameters. 

1 Move the mouse pointer over the chromatogram, and drag from the start point to the 

end point using the right mouse button with the [Shift] key held down.

During the drag operation, the mouse pointer changes to a vertical line. 
The base line is drawn joining the start and end points, and a peak is detected and identified.

• The above operation can be also executed by clicking [Manual Peak Integrate] on the 
[Quantitative] menu. 

• By dragging from the start point to the end point using the right mouse button with the [Ctrl] key 
held down, peaks are detected with the baseline kept horizontal. 

• When [Peak Picked] is selected at [Ref. Ions Based On] in the identification parameters, peak 
integration is performed on the chromatograms of the quantitation ion and reference ion. When 
[Spectrum] is selected, peak integration is performed on only the chromatogram of the 
quantitation ion. 
To perform peak integration on only the chromatogram of a specific m/z, click the chromatogram 
label of that m/z and perform peak integration by following the description in step 1.

No peak is indentified. The automatic identification results have been deleted manually. 

Display Text String Explanation
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5.4.7 Performing Identification Manually

1 Right-click in the range between the start and end times of the currently detected peak 

with the [Shift] and [Ctrl] keys held down. 

A peak is identified.

• The above operation can be also executed by clicking [Manual Identification] on the [Quantitative] 
menu. 

• When the outside of the range between the start and end times of the peak is right-clicked, the 
peak of the quantitation ion having the retention time closest to the right-clicked position is 
identified.

5.4.8 Detecting Unidentified Peaks
This section describes how to detect peaks outside the target compound registered to the Compound 
Table and perform a similarity search on its spectrum. This feature is used for analyzing contamination 
and unforeseen components.
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1 Select [TIC] or [MIC] on the [Pickup Unidentified Peaks] sub-menu on the [Quantitative] 

menu. 

Unidentified peaks in the selected chromatogram are detected and registered to the Identified Results 
Table.

2 Select [Similarity Search for Compound Table] on the [Quantitative] menu.
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3 Select [Unknown] on the [Compound Table Search] tab page in the [Quantitative 

Parameters] sub-window, and click [OK]. 

The similarity search is executed, and [Finish] is displayed at the [Search] column. 

Double-clicking the row of a compound displays the result of the similarity search in the [Similarity 
Search Results] sub-window. 

5.4.9 Calculating S/N
This section describes how to set parameters for calculating noise and S/N. 

1 Click the  (Quantitative Parameters) icon on the [Quantitative] assistant bar. 

2 Click [Noise Calculation] on the [Peak Integration] tab page. 
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3 Set the calculation method and noise range, and click [OK]. 

^ Reference
For details about the parameters, refer to Help.

4 Click the  (Peak Integration) icon on the [Quantitative] assistant bar. 

Peak integration, identification and quantitative calculation are performed on all IDs. 

5 Click the [Results] tab in [Compound Table View]. 

The S/N calculation results are displayed in the Identified Results Table.

No. Explanation

1 Select one of [ASTM], [RMS] or [Peak to Peak].

2 Selecting [Specified Range] calculates noise from the ranges set to [From] and [To]. 
If [Calculation Method] is set to [RMS] or [Peak to Peak], selecting [Auto] automatically 
searches for the range having the smallest noise in the time width set at [Noise Range]. 
When [Calculation Method] is set to [ASTM], noise is calculated by the range obtained 
by subtracting the peak detected time from the processing time. 

1 2
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5.5 Saving New Parameters to Method Files
Save new settings to a method file when data processing parameters (e.g. qualitative parameters or 
quantitative parameters) have been changed.

1 Click [Save Method As] on the [File] menu. 

The [Save Method As] sub-window opens.

2 Enter the file name, and click [Save].

The [Select Method Parameters] sub-window opens.

3 Set the method parameters in the [Select Method Parameters] sub-window, and click 

[OK]. 

1 By [Current Settings], the currently displayed latest parameter settings are saved. By [Acquired 
Settings], the parameter settings that were used at data acquisition are saved. In this example, 
select [Current Settings]. 

2 Select the checkboxes of the parameters to save.

2

1
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5.6 Printing the Content of Data Files
This section describes how to print the content of data files in the [Data Analysis] window. 

1 Load the data file to the [Data Analysis] window, and click [Report] on the [File] menu.

The [Data Report] window is displayed. When a report format is specified during data acquisition or batch 
processing, that report format is set. 

The [Data Report] window is displayed also when the  (Report) icon on the [Qualitative] 

assistant bar or on the [Quantitative] assistant bar is clicked. 

^ Reference
For details on how to paste new report items, see "8.2 Creating Report Formats".

2 Place the report items, and click the  (Preview) icon.

Report format files can be also dragged-and-dropped from the [Report] tab page in the [Data 
Explorer] sub-window onto the [Data Report] window. 

3 Check the report in the preview sub-window, and click [Print].
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5.7 Performing Continuous Postrun Analysis

This section describes how to create a Batch Table from a data file and perform postrun analysis.

1 Click the  (Batch Processing) icon on the [Postrun] assistant bar. 

2 Click the  (Select Data Files) icon on the [Batch] assistant bar. 

The [Select Data File] sub-window is displayed. 

3 Select the data file to register to the Batch Table, and click . 
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5.7  Performing Continuous Postrun Analysis

5

4 At [Selected Data File], select the data file, change the order of the data files by the [Up] 

and [Down] buttons, and click [OK]. 

The Batch Table is created.

5 In the [Data Analysis] sub-window that opens by clicking the [Analysis Type] cell, set the 

analysis details, and click [OK]. 

^ Reference
For details, refer to Help.

6 Click the (Start) icon on the [Batch] assistant bar. 

Continuous postrun analysis is executed.

A batch file made when performing continuous data acquisition can be loaded to perform continuous 
postrun analysis. At this time, settings relating to data acquisition are ignored.
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6Quant Browser

By using the [Quant Browser] window, the quantitative results (concentration, area, height, etc.) of multiple 
data files can be displayed for each compound set to the Compound Table in the method. Quantitative 
results in the list undergo statistical calculation (average, %RSD, maximum, minimum, standard deviation) 
as necessary before being displayed. These results can be printed out as a summary report. 

This chapter describes how to check and edit the quantitative results of multiple data files, and perform 
postrun analysis collectively on multiple data files.

6.1 [Quant Browser] Window

The [Quant Browser] window has four views: [Quantitative Result View] for displaying the quantitative 
calculation results of each data file, [Compound Table View] for displaying the Compound Table and the 
quantitative results of each data file, [Chromatogram View] for displaying chromatograms and sample 
information, and [Calibration Curve View] for displaying the calibration curves of compounds. 

6.1.1 Opening the [Quant Browser] Window

1 Start up the [GCMS Browser] program, and click the  (Quant Browser) icon on the 

[Browser] assistant bar.

The [Quant Browser] window opens.

1

4

2

3
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• The [Quant Browser] window comprises views that are separated by several splitters. These 
views can be resized by dragging these splitters with the mouse.

• In the [Quant Browser] window, you can collectively check the quantitative calculation results of 
up to 1024 data files using the same method file. 

• When [Save Browsing File As] on the [Layout] menu in the [Quant Browser] window is selected, 
the name of the currently loaded method file and data file, file sort order, layout information, and 
other details can be saved as a browsing file (file extension *.qgq). 

• When a file is being edited in a different window, it becomes [Read Only] and cannot be edited. To 
edit the file, close the file in the other window, and open the file again. When there are read only 
files, neither the method file can be saved nor parameters can be edited. 

6.2 Checking the Quantitative Results

In the [Quant Browser] window, multiple data can be easily displayed. 

This section describes how to display data in each of the views in the [Quant Browser] window. 

6.2.1 Opening Method Files
This section describes how to open a method file and display the content of the data file (sample type is 
[Standard]) that comprises the calibration curve contained in that method file in each view. 

1 Click the [Method] tab in the [Data Explorer] sub-window. 

2 Drag-and-drop the method file from the [Data Explorer] sub-window onto the [Quant 

Browser] window. 

No. Name Explanation

1 Quantitative Result View Displays the quantitative calculation results (e.g. concentration, 
retention time, area) of multiple data files, and also displays 
their statistical values (average, %RSD, maximum, minimum, 

standard deviation). Clicking  changes the ID# and 
switches the displayed compound.

2 Compound Table View Displays the Compound Table and Group Table in the currently 
open method file. The identification results and grouping results 
of the data file selected in [Quantitative Result View] are 
displayed. 

3 Calibration Curve View Displays the calibration curve of the ID selected in [Compound 
Table View] in the currently open method file. 

4 Chromatogram View Displays the chromatogram of the ID selected in [Compound 
Table View] in the data file selected in [Quantitative Result 
View.
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6.2  Checking the Quantitative Results

6

The content of the standard sample data file and method file are displayed in the [Quant Browser] 
window.

6.2.2 Opening Data Files to Display Quantitative Results
This section describes how to open a data file of an unknown sample and display the content of the data 
file in each view. 

1 Click the [Data] tab in the [Data Explorer] sub-window. 

2 Drag-and-drop the data file of an unknown sample from the [Data Explorer] sub-window 

onto the [Quant Browser] window. 
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The contents of the data file and method file currently set to the data file are displayed in the [Quant 
Browser] window.

When the data file is dragged-and-dropped from the [Data Explorer] sub-window onto the [Quant 
Browser] window, multiple files can be selected simultaneously. At this time, if the method file is still 
not opened, the content of the method file set to the top data file is displayed. When the loaded 
method file holds calibration curve information, the content of the data file of the standard sample 
that was used when making that calibration curve is also displayed.

6.2.3 Opening Batch Files to Display Quantitative Results
This section describes how to open batch files to display the contents of the method file and data file 
currently set to batch files in each view.
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1 Click the [Batch] tab in the [Data Explorer] sub-window. 

2 Drag-and-drop the batch file from the [Data Explorer] sub-window onto the [Quant 

Browser] window. 

Rows whose sample type is [Standard] in the batch file are searched for, and where the first [Standard] 
row is found, the method file used in that row and all of the data files using that method file are loaded. 

• If no row whose sample type is [Standard] is found in the batch file, a search is performed from 
the 1st row of the batch file for an [Unknown] sample row, and where the first [Unknown] sample 
row is found, the method file used in that row and all of the data files that use that method file are 
loaded. 

• To display the content of the method file and data file using a batch file, the data file and method 
file must be saved beforehand to the same folder as the batch file. 

• Method files and data files can be edited in the [Quant Browser] window. Batch files cannot be 
changed.
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6.2.4 Editing [Quantitative Result View]

Switching the Displayed Data Type

The data type can be selectively displayed by one of the [All], [Standard], [Unknown], [Control], and [Spiked] 

sample types by clicking the  buttons on the toolbar. 

[Standard] refers to the data that comprises the calibration curve in the method file. Even if the 
sample type of the data file is standard sample, the sample type is handled as [Unknown] when the 
data is not the data comprising the calibration curve of the currently open method file. 

Switching Compounds for Displaying the Quantitative Results List

Quantitative results are displayed in [Quantitative Result View] for each compound currently displayed in the 

Compound Table. The compound is switched by the  (ID#) spin buttons at the top of [Quantitative 
Result View] or by selecting the row of the target compound in [Compound Table View]. 

• The error between the concentration value found by quantitative calculation performed on data 
with sample type [Standard] and the set concentration value at the same level in the Compound 
Table can be displayed. 

• The calibration curve of the target compound is displayed in [Calibration Curve View]. 

Displaying Statistical Calculation Results

When the [Statistic] cell checkboxes in the Quantitative Results Table are selected, statistical calculation 
(average, %RSD, maximum, minimum, standard deviation) is performed between data with selected cells, 
and the statistical calculation result items are added to the lowest row of the table. Statistical calculation can 
be performed on cells other than data file name, sample name, sample ID, sample type, set concentration, 
level No., mark, and statistical calculation. 

• [Quantitative Result View] is sorted by file name by clicking [Quantitative Result] - [Sort by 
Filename] on the [View] menu. 

• Items displayed in the [Quantitative Result View] can be selected in the [Table Style] sub-window 
by clicking [Quantitative Result] - [Table Style the [View] menu.
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6.2.5 Fixing the Intensity Axis of [Chromatogram View] to Check 
Quantitative Results
The intensity axis of chromatograms displayed in [Chromatogram View] can be fixed to the identified peaks 
in a specified data file. By fixing the intensity axis, whether or not the chromatogram contains the target 
component and whether or not the peak of the component is at the detection limit or below can be checked 
at a glance.

1 In [Quantitative Result View], select the data file whose intensity axis is to be fixed. 

Select the data file used as the detection limit such as data file for a calibration curve level 1. 

2  Right-click the selected row, and click [Fix the Intensity Axis to This Data.].

 
The intensity axis of the quantitative chromatogram is fixed to the intensity of the selected data file. 
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To fix the intensity axis on a data file that has not been loaded on the quantitation browser, click [Intensity 
Range Setting] - [Chromatogram] on the [View] menu. In the [ID Chromatogram Axis Setting] sub-window, 
select [Fix to identified peak], and specify [Data File]. 

3 Check presence of the target component. 

1 Select the compound ID#1 by the  spin buttons in [Quantitative Result View]. 

The intensity axis of [Chromatogram View] is already fixed to the intensity of compound ID#1 of the 
data file that was used for fixing the intensity axis.

2 Click  on the toolbar. 

The quantitative result for the unknown sample is displayed. 

3 In [Quantitation Result View], select the data file of the unknown sample. 

4 In [Chromatogram View], check whether or not the peak is at the detection limit or below. 

In the figure below, it can be seen that the peak is at the detection limit or above since the 
chromatogram is displayed exceeding the maximum value of the intensity axis of the graph. 

5 Repeat steps 3 and 4, and check the peaks of data files of other unknown samples. 

6 Select the compound ID#2 by the  spin buttons in [Quantitation Result View]. 

At this time, the intensity axis of [Chromatogram View] is already fixed to the intensity of compound 
ID#2 of the data file that was used for fixing the intensity axis.



 GCMSsolution Instruction Manual   135

6.3  Performing Postrun Analysis Collectively on Multiple Data Files

6

7 Repeat steps 3 to 5, and check the peaks of data files of unknown samples for compound ID#3 
onwards. 

6.3 Performing Postrun Analysis Collectively on 
Multiple Data Files

This section describes how to edit [Compound Table View] and perform postrun analysis collectively on 
multiple data files. 

6.3.1 Editing Compound Tables

1 Click  (Edit) in [Compound Table View]. 

2 Click the [Param’s] tab, select the compound to be changed, and change the setting of 

[Conc. 1]. 

In this example, change the [Conc. 1] setting from "100" to "50."

3 Click  (View) in [Compound Table View]. 

The calibration curve is recreated. At the same time, the quantitative results are re-calculated, and 
[Quantitative Result View] is updated. 

• To cancel editing in [Compound Table View], right-click [Compound Table View], and click [Cancel 
Edit] on the displayed menu. 

• Select the items that are displayed in the Compound Table in the [Table Style] sub-window. The 
[Table Style] sub-window is displayed by right-clicking a Compound Table, and clicking [Table 
Style] on the displayed menu. 

6.3.2 Setting the Peak Integration Parameters

1 Click the  (Quantitative Parameters) icon on the [Quantitative] assistant bar. 

2 Click the [Peak Integration] tab in the [Quantitative Parameters] sub-window, and set 

each parameter as required. 

^ Reference
For details about the parameters, refer to Help.
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6.3.3 Performing Peak Integration Collectively on Multiple Data

1 Click the  (Peak Integration for All Data) icon on the [Quant Browser] assistant bar. 

Peak integration is performed on all compound IDs of all data files, and quantitative calculation follows 
after that. 

• To perform analysis on only data files selected in [Quantitative Result View], select [Peak 
Integration] - [Peak Integrate for all IDs] on the [Process] menu. 

• To perform analysis on only the data files currently selected in [Quantitative Result View], select 
[Peak Integration] - [Peak Integrate by ID] on the [Process] menu. 

6.4 Correcting Calibration Curves

1 Click the  (Modify Calibration Curve) icon on the assistant bar. 

The [Calibration Curve] window opens for correcting the calibration curve of the method file currently 
loaded on the [Quant Browser] window. 

2 Change the parameters or perform manual peak integration or manual identification to 

correct the calibration curve.

3 Check the calibration curve, and click  (Save) on the toolbar.

The calibration curve is saved to the currently open method file.

4 Return to the [Quant Browser] window.

When the [Quant Browser] window is displayed, quantitative calculation is performed again based on the 
corrected calibration curve. 
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6.5 Printing Summary Reports

1 Click the  (Summary Report) icon on the assistant bar. 

The [Report] window opens with the default report format loaded. 

To change the content of the summary report, double-click the summary report item, and edit the 
items in the [GCMS Summary(Compound) Properties] sub-window. To save changes made to 

summary report items, click the  (Save) button on the toolbar. Changes are saved to the file 
"MS Quantitative Browser Report.qgr," and this file is used when next printing a summary report. 

2 Click the  (Preview) icon on the [Report] assistant bar.

3 Check the report in the preview sub-window, and click [Print].

6.6 Printing Chromatogram Images

This section describes how to print the chromatogram displayed in the [Quant Browser] window. 

1  Display the chromatogram in the [Quant Browser] window. 

2 Select [Print Current Data] on the [File] menu, and click [Preview]. 

Check the chromatogram in the preview sub-window, and click [Print].



6  Quant Browser

138   GCMSsolution Instruction Manual

When the intensity axis is fixed in [Chromatogram View] in the [Quant Browser] window, the intensity 
axis of the printed graph image is also the same as that in [Chromatogram View].  



GCMSsolution Instruction Manual   139

7
7

7

7

7

7

7

7

7

7

7

7

7

7

7

7

7

7Data Comparison

7.1 Opening the [Data Comparison] Window

In the [Data Comparison] window, displays the chromatograms and spectra of the multiple data files, 
and compares/performs them.

1 Start up the [GCMS Postrun Analysis] program, and click the  (Data Comparison) 

icon on the assistant bar. 

The [Data Comparison] window opens.

No. Item Explanation

1 Data File 
Information

Displays the information of the currently displayed data file. 
To close a data file, right-click on the data file information and click [Close] on the 
displayed menu. 

2 Chromatogram 
View

The chromatogram of the currently open data file is displayed as a "full 
chromatogram" or a "zoomed chromatogram." Three view methods are available, 
Overlay, Stack and Base Shift. [Chromatogram View] displays the MC (MIC and TIC 
also) of the specified mass extracted from data. The chromatogram of the desired 
channel is displayed in the case of GC data files.

3 [m/z] Box Enter the mass of the chromatogram to display in this box. The [m/z] box has a 
history function. A list of previously set masses is displayed in the pull down list, and 
the mass can be selected from this list. 

4 Event Set the event No. of the chromatograms and spectra of all data to display. Either 
enter the event No. directly or select the event No. by clicking the spin buttons.

5 Compound Name Displays the compound name corresponding to the event specified at [Event] and 
the group to which the retention time specified on the chromatogram belongs for the 
instrument method of the data file currently selected by the [Data] button. 

6 Move/Parallel 
Move Buttons

By clicking these buttons, the chromatogram of the selected data can be moved and 
expanded/reduced as desired in both the time and intensity axis directions. 

1

3
4
5

6

7

8

2
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• Chromatograms can be displayed shifted by an equal interval by right-clicking on the 
chromatogram and selecting [Base Shift] on the displayed menu. 

• Chromatograms can be pasted to other applications as image files by right-clicking on the 
chromatogram and selecting [Copy] on the displayed menu.

• To close all data, click [Close] on the [File] menu.

7.2 Displaying Chromatograms and Spectra

This section describes how to display chromatograms and spectra on the [Data Comparison] window.

1 From the [Data] tab page in the [Data Explorer] sub-window, drag-and-drop the multiple 

data files onto the [Data Comparison] window. 

The content of the data files is displayed in the [Data Comparison] window.

Data files measured with GC-2030 detectors cannot be selected. Data files measured with GC-2010 
detectors can be selected.

7 Data Selection 
Buttons

Select the data No. to set to a selected state. 

8 Spectrum View [Spectrum View] displays the spectrum of the retention time specified on the 
chromatogram. When multiple data sets are loaded, the spectra are displayed in 
multiple levels. A similarity search can be performed from the menu that is displayed 
by right-clicking on the spectrum to be processed. 

No. Item Explanation
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7.2.1 Displaying the Spectrum of a Specific Retention Time

1 In [Chromatogram View], double-click with the mouse pointer over the retention time to 

extract the spectrum. 

The spectrum of event 1 at that retention time position is displayed in [Spectrum View].

To display the chromatogram or spectrum of other events, switch to the desired chromatogram or 
spectrum using the [Event] spin buttons. 

7.2.2 Comparing Spectra with the Intensity Axis of the Spectra Fixed
The intensity axis of all spectra displayed in [Spectrum View] can be fixed to the spectrum having the 
greatest intensity. By fixing the intensity axis in this way, the spectra of data files acquired by altered 
conditions can be compared to find the optimum data acquisition settings (CE or product ion). 

1 In [Chromatogram View], double click at the retention time position of the compound 

whose spectrum is to be checked. 

The spectrum of the specified retention time is displayed.

2 Check the compound name in [Chromatogram View]. 



7  Data Comparison

142   GCMSsolution Instruction Manual

3 Right-click on [Spectrum View], and select [Fix Intensity Axis] on the menu that is 

displayed. 

The intensity axis of the spectrum is fixed to match the spectrum having the greatest intensity.

4 Compare the spectra to find the optimum CE or precursor ion. 

5 Select the compound of the next event using the  spin buttons at [Event]. 

The chromatogram and spectrum of the data file are displayed. 
The intensity axis of [Spectrum View] is fixed to the spectrum having the greatest intensity. 

6 Find the optimum CE or precursor ion.

7.2.3 Displaying the Chromatogram of a Specific m/z

1 At [m/z], enter the m/z for which the chromatogram is to be displayed.
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The chromatogram of event 1 is displayed.

To display the chromatogram of other events, switch to the desired chromatogram using the [Event] 
spin buttons. 

7.2.4 Moving Chromatograms
This section describes how to move chromatograms in parallel with the time axis direction. 

1 Select the No. of the data to move by the data selection button. 

The following operations are performed on the chromatogram having this data No. 

2 Click  (Move Left/Right).

To move parallel in the intensity axis direction, click the  button. 

3 Move the mouse over the chromatogram, and drag from the start point to the end point 

in the move direction.

The chromatogram moves to that point.
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7.2.5 Expanding/Reducing Chromatograms
The chromatogram of selected data can be expanded or reduced as desired. 

1 Set the desired chromatogram to a selected state. 

2 Click the  (Base Point) button, and click the expanding/reducing base point on the 

chromatogram to specify that point. 

The base point is set by a cross line. This base point will be the origin from where expanding/reducing will 
be performed, and only that point will be processed as fixed and will not move. If the base point button is 
already in a clicked state, click the base point button again to deselect that point, and click the button 
again to set the base point. 

3 Click  (Zoom Left/Right) or  (Zoom Up/Down). 

4 Drag the chromatogram to the desired expanding/reducing position.

The chromatogram is expanded or reduced to that point.

• Parallel move processing can be used in combination with expanding/reducing processing.

• To cancel a parallel move to return data to its original state, right-click on the chromatogram, and 
click [Initialize Process] on the displayed menu. 

7.2.6 Performing Calculations on Chromatograms and Spectra
Subtraction can be performed on the chromatogram and spectrum of the currently displayed first and 
second data files. 

1 Double-click the icon of the data file to load, and load the two data files to perform 

calculations on.
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2 Click the  (Operation Mode) button on the toolbar to switch to the calculation mode.

The comparison chromatogram is displayed under the zoomed chromatogram in [Chromatogram View], 
and the comparison spectrum is displayed at the lowermost level of [Spectrum View]. Even if three or 
more data files are loaded, the calculation results of data files 1 and 2 will be displayed at all times.

3 Click the subtraction operation (  or ) to execute. 

By , the result of subtracting chromatogram 2 from chromatogram 1 is displayed at the lower level. By 

, the result of subtracting chromatogram 1 from chromatogram 2 is displayed at the lower level. 
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7.3 Printing Graph Images

The currently displayed chromatogram and spectrum can be printed.

1 Click [Print Image]-[Preview] on the [File] menu. 

The [Report] window opens with the default report format in a set state.

2 Check the report in the preview sub-window, and click [Print].
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8Reports

This chapter describes how to use the report function to print chromatograms and quantitative calculation 
results.

With the report function, you combine report items, such as sample information, chromatograms, and 
quantitative results, to create reports in various formats.

8.1 Opening the [Report] Window

1 Start up the [GCMS Postrun Analysis] program, and click the  (Report Format) 

icon on the [Postrun] assistant bar. 

The [Report] window opens.

The [Report] window can also be opened from the  (Report Format) icon on the [Browser] 

assistant bar of the [GCMS Browser] program. 

No. Name Explanation

1 Toolbar (report 
creation tools)

Various buttons corresponding to the currently displayed window are displayed. 

2 Toolbar (report 
item tools)

Icons corresponding to the items to be placed are displayed on this toolbar. Items, 
such as data file chromatograms and quantitative result information, can be pasted 
to reports using the item buttons on the toolbar.

1
2

3
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The buttons on the toolbar can be turned into a floating palette by either double-clicking an area 
enclosing the respective buttons or by dragging the buttons to the outside of the toolbar. 

Use this feature, for example, to make the toolbar as narrow as possible. To return the buttons to 
inside the toolbar, either double-click the title bar of the palette or drag the palette to inside the 
toolbar. 

8.2 Creating Report Formats

In [Report] window, either set new report formats or output reports using pre-created templates. Results 
(e.g. spectrum information) to output must be processed in advance and saved to a data file.

8.2.1 Manually Setting Report Formats
This section describes an example of how to make a new report format in the [Report] window using 
chromatogram items.

1 Click the  (Report Format) icon on the [Postrun] assistant bar or the [Browser] 

assistant bar. 

The [Report] window opens.

2 Select [Page Setup] on the [File] menu.

The [Page Setup] sub-window opens.

3 Layout View This is the report paper screen. Click an item button on the toolbar, and drag on 
screen to place the desired item to print.

No. Name Explanation
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In this sub-window, set the paper size to match the printer paper source, the orientation (portrait or 
landscape), and the margins of the report.

3 Click  (Chromatogram) on the toolbar, and drag it onto the layout view.

Drag from one corner to the diagonally opposite corner.

4 Correct the display positions or display items on each tab page of the [GCMS 

Chromatogram Properties] sub-window, and click [OK]. 

Drag mouse diagonally
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The sub-window closes, and the newly set items are placed on the layout.

• To re-open the [GCMS Chromatogram Properties] sub-window, double-click inside the item 
frame. 

• When making layouts that straddle multiple pages, click the  (Insert) button on the toolbar 

to insert a page after the currently displayed page. 

To display the header and footer, select [Header/Footer] on the [View] menu on the menu bar, and set 
these in the [Header/Footer] sub-window. 

5 To check the print content of report format files, click the [Data] tab in the [Data 

Explorer] sub-window, and drag-and-drop the target data file onto the format window. 
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The chromatogram information of the data file is displayed in the [Report] window.

• To delete an item, right-click on the item to delete, and click [Delete] on the displayed menu.

• When the data file is not displayed in the [Data Explorer] sub-window, click  (Select 

Project), and specify the folder containing the data file.
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6 Click the  (Preview) icon on the [Report] assistant bar.

7 Check the report in the preview sub-window, and click [Close].

8 Click [Save As] on the [File] menu. 

The [Save Report Format File As] sub-window opens. 

9 Select the folder to save the report format file in, enter a file name, and click [Save]. 

The newly set report format is saved as a report format file. 

8.2.2 Using a Template to Set a Report Format

1 Click [Option] on the [Tools] menu. 

The [Setting Options] sub-window opens. 

2 Select [Prompt on File New] at [Report Format File] on the [File New] tab page, and click 

[OK].
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3 Click the  (New) button on the toolbar. 

The [File New] sub-window opens.

4 Select [Use Template], then select the template file from the list of templates, and click 

[OK]. 

The content of the template file is loaded to the [Report] window. 
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5 Edit the report format and save the template file under a new name.

8.3 Printing Reports

8.3.1 Printing Data Processing Results in the [Data Analysis] Window
This section describes how to print reports from data files on the [Data Analysis] window. 

1 Start up the [GCMS Postrun Analysis] program, and load the data file to the [Data 

Analysis] window.

The same report is output in either of the qualitative and quantitative sub-windows. 

2 Click the  (Report) icon on the [Qualitative] assistant bar or the [Quantitative] 

assistant bar. 

The [Data Report] sub-window opens.
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3 Click the  (Report) tab in the [Data Explorer] sub-window. 

4 Drag-and-drop the target report format file onto the [Data Report] window. 

5 Click the (Preview) icon on the [Data Report] assistant bar. 

6 Check the report in the preview sub-window, and click [Print].
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8.3.2 Printing Reports at Batch Processing
This section describes how to print reports during batch processing.

1 Open the [Batch Table] window, and load the batch file.

2 Select the [Report Output] cell of the row to be printed, and set the name of the report 

format file to print in the [Report File] cell. 

3 Click the  (Start) icon on the [Batch] assistant bar. 

The report is automatically output when processing ends. 



GCMSsolution Instruction Manual   157

A
A

A

A

A

A

A

A

A

A

A

A

A

A

A

A

A

Appendix
AMaintenance

A.1 Installing the Software

This chapter describes the procedure for installing the software.

A.1.1 Preparations for Installation
Check the following points before installing the software.

• Installation disk
The installation disk is provided on a DVD-ROM. 
When the software installation program is executed, the files are decompressed automatically and copyied 
to the hard disk on the PC. 

• The software runs on Windows. Make sure that the OS running on the PC is appropriate. 

• Before re-installing GCMSsolution, be sure to uninstall it first.

^ Reference
See "A.2 Uninstalling the Software".

• Use LabSolutions to analyze the data measured with GC detectors.

A.1.2 Installing GCMSsolution

1 Turn ON the PC, start up Windows and insert the GCMSsolution installation disk into the 

DVD-ROM drive. 

The [Autorun] window opens.

The [Do you want the following program to allow changes to this computer?] dialog box may be displayed. 
In this case, click the [Yes] button to proceeded.

If the above screen does not open automatically, click the [Start] menu on the taskbar. Enter 
"E:autorun.exe", and press the [Enter] key. (In this example, "E:" indicates the DVD-ROM drive.)
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2 Click [Install] in the [Autorun] window.

After a time the [Welcome to the InstallShield Wizard for GCMSsolution] window opens.

• It takes about one minute before the [Welcome to the InstallShield Wizard for GCMSsolution] window 
is displayed.

• When .NET Framework 4.6.1 or later is not installed, the installation window of .NET Framework 
opens.

Click [Install].
When the message "The installation of GCMSsolution requires a reboot" is displayed, click [Yes].

After the PC is rebooted, repeat the installation procedure from step 1.
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3 Click [Next] in the [Welcome to the InstallShield Wizard for GCMSsolution] window.

The [User Authentication Mode Select] window opens.

4 Select the user authentication mode in the [User Authentication] window. 

Select [User Database in GCMSsolution] if CLASS-Agent is not to be used. When using CLASS-Agent, 
first read the following notes and select the required mode. 

• When the optional CLASS-Agent software is used, user information can be managed using the 
Shimadzu user authentication tool. Use of the Shimadzu user authentication tool allows user 
information to be shared with other software (e.g. CLASS-Agent or GCsolution) that utilize the 
user authentication tool. 

• When using the Shimadzu user authentication tool to manage user information, be sure to install 
Shimadzu user authentication tool Ver. 1.09 or later. If the software is run on a 64-bit version of 
Windows 7 or Windows 10, be sure to install Shimadzu user authentication tool Ver. 1.10 or later.

• If the Shimadzu user authentication tool is set to be used when the system is already being run 
using GCMSsolution, the user information will be switched to the information that is being 
managed by the Shimadzu user authentication tool. For this reason, users who have been using 
GCMSsolution and who have not been registered to the Shimadzu user authentication tool must 
be re-registered. Register the required users by referring to "2.4 Registering (Changing/Deleting) 
Users" in the GCMSsolution Administration Manual. 
Also, password and other user information set by the Shimadzu user authentication tool are 
enabled when a user ID or user name for the same name is set to GCMSsolution and the 
Shimadzu user authentication tool. 

^ Reference
For details on installation of the Shimadzu user authentication tool and system configuration, refer to 
the Shimadzu user authentication tool Instruction Manual. 
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5 Click [Next] in the [User Authentication] window. 

The [Customer Information] window opens.

6 In the [Customer Information] window, enter the name of the user at [User Name] and 

the department that the user belongs to at [Organization], and click [Next]. 

The [Destination Folder] window opens. GCMSsolution is now installed to the folder that is displayed as 
the GCMSsolution installation directory.

7 To change the folder to install GCMSsolution to, click [Change] in the [Change Current 

Destination Folder] window. 

The [Change Current Destination Folder] window opens.

Select the folder to install GCMSsolution to.
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• Unless you have good reason to do otherwise, leave the currently displayed folder as the 
installation directory.

• When multiple Windows users use GCMSsolution, the following operation may be impossible if a 
new data folder is created in a location other than the Data folder (or its sub-folders) at the 
installation destination.

• Creating sub-folders

• Saving files

• File reference by other users

In such case, change the folder security settings using the appropriate Windows function.

Click [OK]. The display returns to the [Destination Folder] window. 

8 Click [Next] in the [Destination Folder] window.

The [Ready to Install the Program] window opens.

9 Click [Install] in the [Ready to Install the Program] window.

The [Installing GCMSsolution] window opens, and GCMSsolution is installed.
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To cancel installation midway, click [Cancel]. 

A window for confirming whether or not to cancel installation opens. 

To continue with installation, click [No]. To cancel installation, click [Yes]. 

10 Install the driver. 

For Windows 10, the driver installation window does not open. Proceed to step 11.

1 The [Would you like to install this device software?] window opens. Click [Install]. 

The USB driver for MS is installed.

2 If the following message is displayed, click [Install].

11 When the display returns to the GCMSsolution installer window, click [Finish]. 
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A.2 Uninstalling the Software

1 Select [Control Panel] on the [Start] menu on the taskbar. 

For Windows 10, press the [X] key with the [Windows] key held down, and click [Control Panel] from the 
displayed list.

2 Click [Uninstall a Program].

3 At [Name] select [GCMSsolution], and click [Uninstall] on the right-click menu.

4 In the [Are you sure you want to uninstall GCMSsolution?] confirmation window, click 

[Yes]. 

To re-install GCMSsolution after uninstalling it, first restart the PC, and then install GCMSsolution.



A   Maintenance

164   GCMSsolution Instruction Manual

A.3 Connecting to the Instrument

This section describes how to connect the respective MS unit and GC unit to the computer, as well as how 
to install the MS or GC driver.

A.3.1 Connect the PC to the MS Unit
The MS unit connects to the computer via a USB cable.

Connect the USB cable from a USB port on the computer to the USB port on the back panel of the MS unit.

Make sure that the MS is turned ON. 

Always use a USB cable specified by Shimadzu.

To reduce the risk of the cable becoming disconnected, connect to a USB port on the back of the computer.

A.3.2 Connect the PC to the GC Unit
The GC unit connects to the computer via a USB cable or a Ethernet cable.

 Connecting via a Ethernet cable

1 Connect the Ethernet cable to the connector on the back panel of the GC unit.

2 Turn ON the GC power.

The GC unit starts.

3 Press  (Home) - [Function] - [Configuration] - [Transmission Settings] on the GC unit.

The [Transmission Settings] window opens.
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4 Press the [Ethernet] tab, set [IP Address], [Subnet Mask], [Default Gateway], and press 

[Apply].

5 Turn ON the GC power.

The GC unit starts.

6 Start up the [GCMS Real Time Analysis] program, and click the [System Configuration] 

icon on the [Real Time] assistant bar.

The [System Configuration] sub-window opens.
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7 Double-click [Instrument 1] at [Modules Used for Analysis].

The [Instrument] sub-window opens.

8 Select [GC-2030] at [GC Type].

9 Select [Ethernet] at [GC Communication].

10 Enter the IP address of GC in [IP Address].

Enter the IP address set in the [Transmission Settings] window on the GC unit in step 4.

11 Click [OK].

Close the [Instrument] sub-window.

^ Reference
For details on the system configurations, see "2.1 System Configuration".
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 Connecting via a USB cable

1 Connect the USB cable from a USB port on the computer to the USB port on the back 

panel of the GC unit.

Always use a USB cable specified by Shimadzu.

To reduce the risk of the cable becoming disconnected, connect to a USB port on the back of the 
computer.

2 Turn ON the GC power.

The GC unit starts.

3 Press  (Home) - [Function] - [Configuration] - [Transmission Settings] on the GC unit.

The [Transmission Settings] window opens.

4 Press the [USB] tab and then press [Apply].
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5 Follow steps 5 to 7 in " Connecting via a Ethernet cable"

6 Select [USB] at [GC Communication].

7 Enter the serial number of GC in [Serial Number].

Enter the serial number displayed in the [Transmission Settings] window on the GC unit in step 4.

8 Click [OK].

Close the [Instrument] sub-window.

^ Reference
For details on the system configurations, see "2.1 System Configuration".
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A.3.3 Installation of the Driver for MS or GC
In Windows 10 or Windows 7, the driver is installed automatically when the MS or GC unit and USB cable 
are connected. If the driver is not installed automatically, install the driver according to the following 
procedure.

GCMSsolution must be installed on the PC before installing the driver for MS.

1 Connect the MS or GC to the PC using USB cable while Windows is running.

2 From the Windows Start Menu, select [Control Panel]. Click [System and Security].

For Windows 10, press the [X] key with the [Windows] key held down, select [Control Panel] from the 
displayed list, and click [System and Security].

3 Click [Device Manager].

For Windows 10, click [System] and click [Device Manager] from the list displayed on the left side of the 
sub-window.

[Device Manager] window opens.
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4 Double-click the [GCMS-TQ Series] or [GC-2030] icon in [Other devices].

Although the explanation below uses the figures for MS driver installation, perform a similar 
operation for the GC driver as well.

The [GCMS-TQ Series Properties] sub-window opens.

5 Click the [Update Driver] on the [Driver] tab.

The [Update Driver Software] sub-window opens.

6 Click the [Browse my computer for device software].
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7 At [Search for driver software in this location], set "C:\GCMSsolution\Program" for the 

MS driver, and "C:\GCMSsolution\Common" for the GC driver, and click [Next]. ("C:" 

refers to the drive on which GCMSsolution is installed.)

Installation of device driver starts.

If the [Would you like to install this device software?] window opens. Click [Install]. 

8 Click [Close].



A   Maintenance

172   GCMSsolution Instruction Manual

A.4 Easy sTop

Use of Easy sTop enables septa or glass inserts to be replaced without venting the vacuum system. The 
time required for instrument re-stabilization is significantly reduced, and re-tuning is usually not necessary. 

Easy sTop sets the temperature of the injection port, column oven and interface to 70 °C or less. It may 
take up to 30 minutes until replacement of the glass inserts or septa is possible.

1 Double-click one of the consumables icons at the instrument monitor. 

The [Consumable] tab page in the [Monitor Settings] sub-window opens.
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2 Click [Easy sTop]. 

The [Easy sTop] sub-window is displayed, and the temperature of the injection unit, column oven and 
interface drops. When each of the temperatures falls to 70 °C or below, the [Push the replace button] 
status is displayed in the [Easy sTop] sub-window. 
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3 Click [Replace], and then start replacing the  or glass insert of the injection unit. 

For details on the replacement procedure, refer to the septum replacement procedure and insert 
replacement procedure in the [MS Navigator] sub-window. 

Clicking [Replace] stops supply of the carrier gas. 

Leaving supply of carrier gas stopped for a long time sometimes lowers the column performance. 
So, complete replacement as soon as possible. 

4 After replacement, click [Complete] in the [Easy sTop] sub-window. 

The temperature of the injection unit, column oven and interface returns to the original set point. 
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A.5  Resetting the Number of Uses/Operation Time
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5 Reset the number of uses of [Septum] or [Glass Insert]. 

For details on how to reset the number of uses, refer to step 3 onwards of "A.5 Resetting the Number of 
Uses/Operation Time".

A.5 Resetting the Number of Uses/Operation Time

GCMSsolution's instrument monitor counts the number of uses and operation time of each of the 
consumables.

When consumables have been replaced or the ion source has been cleaned, for example, reset the 
numbers of uses and operation time by following the procedure below. 

1 Double-click one of the consumables icons at the instrument monitor. 

The [Consumable] tab page in the [Monitor Settings] sub-window opens.

2 Click [Reset Consumables]. 

The [Reset Consumables] sub-window opens. 

ZStanius
Highlight
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3 Either click [Clear] for the consumable that has just undergone maintenance, or enter 

"0" in the operation time cell and click [OK]. 

The display returns to the previous sub-window.

4 Click [OK] in the [Monitor Settings] sub-window. 

The sub-window closes. 

A.6 Changing the Replacement Guidelines for the Septa 
and Glass Inserts

The frequency that the septum must be replaced changes according to the needle thickness of the syringe 
in use. Recommended syringes can be used about 100 times, and recommended gas-tight syringes can 
be used about 30 times. 

Also, the frequency that glass inserts must be replaced changes according to the sample. Set replacement 
guidelines according to the sample. 

1 Click the (System Configuration) icon on the [Real Time] assistant bar. 

The [System Configuration] sub-window opens.



 GCMSsolution Instruction Manual   177

A.6  Changing the Replacement Guidelines for the Septa and Glass Inserts

A

2 Double-click the [SPL1] icon at [Modules Used for Analysis]. 

The system configuration sub-window of the injection unit opens.

3 Enter [Septum Used Counts] and [Insert Used Counts] settings. 

To return settings to their defaults, click [Initialize].

4 Click [OK].

The display returns to the [System Configuration] sub-window.
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5 Click [Set].

The replacement guidelines for the septa and glass inserts are changed. 

A.7 Column Maintenance

The retention time of measurement data sometimes differs from previous data, for example, when the 
column has been cut to change its length or when a column from a different lot is used. In cases such as 
this, the MS instrument parameters or retention times in the Compound Table must be adjusted so that the 
target compound can be reliably measured and identified. 

In such cases, use the AART (automatic adjustment of retention time) function to batch-adjust all retention 
times based on retention indices assigned to target compounds. 

1. Perform single run on the reference compound (mainly, n- alkane).

2. Identify the reference compound.

3. Execute the AART function, and adjust the retention times of the method file.

4. Measure the standard sample of the target compound, and adjust the retention time.

^ Reference
For a more detailed description of operations, refer to the AART Instruction Manual in the \Manual 
folder of the GCMSsolution installation folder.
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A.8 Errors and Remedies

A.8.1 The Instrument Is Not Properly Recognized
When the software is started up, the instrument sometimes cannot be recognized properly and the 
following error messages are sometimes displayed:

[0d80] MS Communication Hardware is not connected.

[0d00] GC Communication Hardware is not connected.

If this happens, click [Help] and check connections and settings according to the procedure described in 
the error message that is displayed. 

A.8.2 Messages Displayed at Startup
This section describes messages that are displayed when the [Real Time Analysis] program is started up.

[1317] The hardware configuration for this method is different from the current instrument 
configuration. The measurement condition in the method file is modified according to the current 
instrument configuration.

This message is displayed when the method file used for the previous data acquisition and the method file 
set to the Batch Table differ from those for the current instrument configuration. To display the method file 
or execute realtime batch, the system configuration information currently saved in the method files must be 
matched to the current instrument configuration. 

To match the system configuration information currently saved in the method files to the current instrument 
configuration, click [OK]. 

Clicking [Cancel] cancels loading of method files and start of realtime batch. 

When the system configuration information has been matched to the current instrument configuration, be 
sure to check the various parameters since defaults are entered to units in a different configuration. 

A.8.3 Windows Does Not Start Up
If an error message is displayed when Windows does not start up normally after the PC is turned ON, 
check the instruction manual provided with the PC. 
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Appendix BBefore PDF 
Output

The GCMSsolution provides the capability to output a report in the PDF (Portable Document Format) when 
it is used with AdobeR AcrobatR, a tool for creation, management, and editing of PDF documents.

B.1 Before PDF Output

To use this function, the following product must be set up beforehand:

Adobe Acrobat (Version 9.2 or later)

For details on how to install this product, perform "Standard Setup" by following the on-screen instructions 
that are automatically launched when the Acrobat product CD-ROM is inserted into the CD-ROM drive. 

Adobe Acrobat is not included in this software package. It must be purchased separately. 

Adobe Acrobat Reader that is provided on the GCMSsolution installation disk only allows PDF electronic 
documents to be viewed and does not provide a function for creating PDF files. 

B.2 Installing the Postscript Printer Driver

1 Click [Devices and Printers] on the Windows [Start] menu.

For Windows 10, click the Start button on the taskbar, and click [Settings]. Click [Devices] in the displayed 
sub-window, and then click [Devices and printers] in [Related settings] of the sub-window that is 
displayed.

2 Click [Add a printer]. 

The [What type of printer do you want to install?] window opens.
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3 Click [Add a local printer]. 

For Windows 10, this windows is not displayed. Click [The printer that I want isn't listed] in the [Add a 
device] sub-window. Then, select [Add a local printer or network printer with manual settings] in the sub-
window that is displayed.

The [Choose a printer port] window opens.

4 Select [Use an existing port] and [FILE: Print to File] for the port. 

The [Install the printer driver] window opens.
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5 Click [Have Disk]. 

The [Install From Disk] window opens. 

6 Click [Browse].

The [Locate File] window opens.
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7 Select "PDF_Setup.inf" from the "\PDFOutput\English" folder in the GCMS installation 

disk, and click [Open]. 

For Windows 10 or Windows 7 (64 bit version), select “PDF_Setup.inf” from the “\PDFOutput\English\x64” 
folder in the GCMS installation disk.

8 In the [Install From Disk] window, check that the path to "PDF_Setup.inf" is correctly 

selected, and click [OK]. 

9 In the [Install the printer driver] window, select "LabSolutions PDF Printer," and click 

[Next]. 
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10 In the [Type a printer name] window, check the printer name selected in Step 9 is 

correctly entered, and click [Next].

If the printer needs to be renamed, rename it at this step. 

When the [User Account Control] window opens, enter the password of the administrator account, and 
click [Yes]. 

When the [Would  you like to install this device software?] window is displayed, click [Install]. 

This starts installation of the driver.
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11 Click [Finish].

12 When installation is completed, load the data file to the [Data Analysis] window in the 

[GCMS Postrun Analysis] program, and click [Save Data File As] on the [File] menu. 

The [Save Data File As] sub-window opens. 

Check whether or not PDF output is set to enabled. If "PDF File (*.pdf)" is selected and [Save] is clicked, 
the data report will be saved in PDF format.

If a data file not set with a data report format is converted and saved as a PDF file, a PDF containing 
a white sheet without any data will be generated. 
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B.3 Setting PDF Output

This section describes how to set output to PDF file when outputting a report from GCMSsolution.

1 Click [Option] on the [Tools] menu. 

2 On the [PDF Export] tab page, select the [Redirect Report to PDF file] checkbox, and 

select [Normal Speed Mode (Acrobat Distiller)].

^ Reference
For details about parameters, refer to Help.

3 Click [OK].
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Appendix
CExporting Files

With GCMSsolution, chromatograms, spectra, data analysis results, and other information can be exported 
to other file formats. 

(Note1) GC/MS/MS data files cannot be converted to this format.

C.1 Exporting from the [Data Explorer] Sub-Window

In the [Data Explorer] sub-window, data files can be converted to files of various formats.

GC/MS/MS data files can be converted to ASCII format , AIA format, mzData format, and mzXML format.

1 Select the data files (multiples files can be selected) in the [Data Explorer] sub-window, 

and select the file format on the [File Convert] sub-menu on the right-click menu. 

The [To *** File] sub-window is displayed.

"***" stands for the file format selected in the sub-menu. 

Window/Sub-Win-
dow

File Type Convertible File Format (Extender)

[Data Analysis] 
window

Data files ASCII files (*.txt)

AIA files (*.cdf)

[Data Explorer] 
window

Data files ASCII files (*.txt)

AIA files (*.cdf)

JCAMP files (*.jdx)(Note1)

mzData files (*.mzData)

mzXML files (*.mzXML)

[Library Editor] 
window

Library files Text files (*.txt)

JCAMP files (*.jdx)

[Batch table] 
window

Batch files ASCII files (*.txt)
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2 Select the folder as the save directory, and click [OK]. 

To cancel file conversion, click [Terminate] in the progress sub-window.

When converting to ASCII format, select the items to export in the [Output Items] sub-window that 
opens by clicking [Output Items]. 

C.2 Exporting Data to AIA Files from the [Data Analysis] 
Window

Data files opened in the [Data Analysis] window can be converted to AIA files. 
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C.3  Exporting Data by Batch Processing

C

1 Load data to the [Data Analysis] window.

2 Click [Save Data File As] on the [File] menu. 

3 Select [AIA (Andi) File (*.cdf)] at [Save as type] in the [Save Data File As] sub-window. 

4 Specify the AIA file name at [File name], and click [Save]. 

C.3 Exporting Data by Batch Processing

Analysis results can be exported to a file each time that processing of one row of the Batch Table ends or 
when all batch processing ends.

1 Open the [Batch Table] window, and load the batch file.

2 Click the  (Settings) icon on the [Batch] assistant bar. 

The [Settings] sub-window is displayed. 
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3 On the [ASCII Convert] tab page, select the [Output ASCII File(s)] checkbox.

When converting to AIA format, specify the appropriate settings on the [File Convert] tab page.

4 Set the parameters, and click [OK].

^ Reference
For details about parameters, refer to Help.

5 Click the  (Start) icon on the [Batch] assistant bar. 

Batch processing is started, and data is converted to the ASCII file format after it is analyzed.

C.4 Exporting from the [Library Editor] Window

Compound information can be exported from the [Library Editor] window.

Library spectra can be converted to JCAMP format only in the case of private libraries. 

1 Start up the [GCMS Postrun Analysis] program, and click the  (Library Editor) icon 

on the [Postrun] assistant bar. 

The [Library Editor] window is displayed.
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C.4  Exporting from the [Library Editor] Window

C

2 Click [Open Library] on the [File] menu.

3 In the [Open Library File] sub-window, specify the library file, and click [Open].

4 Set the criteria in the Library Search Parameters Table. 

5 Click [Start] on the [Index Search] menu. 

The compounds in the library are filtered using the search parameters.

6 Click [Export Search Results] on the [Index Search] menu. 

The [Export Index Search results] sub-window opens.
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7 Specify the text file name at [File name], and click [Save]. 

The compound information is converted to a text file.

To convert spectra to JCAMP format, select [JCAMP File(*.jdx)] at [Save as type]. 

C.5 Exporting Batch Files from the [Batch Table] 
Window

The content of Batch Tables can be converted to a text file. 

1 Load the batch file in the [Batch Table] window.

2 Click [Save Batch File As] on the [File] menu. 

The [Save Batch File As] sub-window opens.



 GCMSsolution Instruction Manual   195

C.5  Exporting Batch Files from the [Batch Table] Window

C

3 Select [Text File (*.txt)] at [Save as type].

4 Specify the text file name at [File name], and click [Save]. 

The Batch Table is converted to a text file.
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Appendix
DSpecifications

D.1 Workstation

PC CPU Intel® CoreTM i5-7500 (3.4 GHz) equivalent or greater

Internal memory 8 GB or more

Hard Disk 500 GB or more

OS Windows 10 Pro 64-bit version

Display 21.5" wide color LCD, number of pixels 1920 x 1080 dpi

Printer Laser printer, A4 or larger
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